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Software License Agreement
The Easy Grade Pro™ software program is licensed by
ORBIS Software™, Inc. for use only on the terms and
conditions that follow. Refer to the License/Registration
Card for the specific license type. Use of the Easy Grade
Pro™ software indicates that you accept all terms.
• To use Easy Grade Pro™, you must have a valid
single-user license or your employer must have a valid
site license. Under no condition does a site license
apply to more than one school or college-level
department.
• For Single-user License: You may use Easy Grade
Pro™ on any computer in which you are the primary
user. Your name and registration number must appear
in the Easy Grade Pro™ title screen. If you transfer the
software license you may not retain a copy and the
new owner must agree to the terms of this agreement.
• For Site License: You may use Easy Grade Pro™ on
any computer owned by the employer and on any
computer in which you are the primary user. Your
employer’s name or site name and registration
number must appear in the Easy Grade Pro™ title
screen. The software license may not be transferred
without permission from Orbis Software™, Inc.
• Windows/Macintosh Platforms: You may use Easy
Grade Pro™ only on the platform(s) specified on the
license card.
• You may use Easy Grade Pro™ only for its intended
purpose. You may not modify the software, make any
attempt to discover the source code or create
derivative works based on the software.
Replacement of CD-ROM
If an original CD-ROM becomes defective it will be
replaced without charge if returned within ninety days of
the date of purchase.
Copyright
Copyright © 1992-2000 by ORBIS Software, Inc. All rights
reserved. This software and manual may not be copied or
transferred to any medium in whole or part except as
permitted by U.S. Copyright Law or by written permission
from ORBIS Software, Inc.
Warranty
The Easy Grade Pro program and documentation are
sold “as is” without warranty of any kind. It is your
responsibility to verify the results obtained from the use
of the program. ORBIS Software reserves the right to
make changes in the program and documentation at any
time and without notice.
II

ORBIS SOFTWARE, INC. MAKES
NO WARRANTIES, EITHER
EXPRESSED OR IMPLIED,
INCLUDING BUT NOT LIMITED
TO IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE.
THE EXCLUSION OF IMPLIED
WARRANTIES IS NOT
PERMITTED BY SOME STATES.
THE ABOVE EXCLUSION MAY
NOT APPLY TO YOU. THERE MAY
BE RIGHTS THAT YOU HAVE
THAT VARY FROM STATE TO
STATE. IN THAT EVENT, ANY
IMPLIED WARRANTIES ARE
LIMITED IN DURATION TO
THIRTY(30) DAYS FROM THE
DATE OF DELIVERY OF THE
SOFTWARE.
In no event will ORBIS Software, Inc. be liable to any
person for any direct, indirect, special, incidental,
consequential or similar damages. In no case shall
ORBIS Software Inc.'s liability exceed the purchase price
for the software.
Trademark Information
ORBIS Software™ and Easy Grade Pro™ are trademarks
of ORBIS Software, Inc. and use of them without prior
consent is prohibited.
“Apple”, “Macintosh”, and “Power Macintosh” are
registered trademarks of Apple Computer, Inc.
“Windows” is a registered trademark of Microsoft
Corporation.
Contacting Orbis Software
To contact ORBIS Software, write to P.O. BOX 73745,
Puyallup, WA 98373 or call (253) 848-6899 during normal
business hours (Pacific Time). Fax: (253) 848-6505. From
the Internet, you can reach Orbis Software’s Home Page
at http://www.orbissoft.com.
Dedication
Easy Grade Pro is dedicated to Tommy. If it weren't for
him, there would be no Easy Grade Pro.
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Chapter 1

Getting Started
In this chapter, you'll learn what’s needed to use Easy Grade Pro and how to install it. You'll
also learn the structure of this manual and the special features of Easy Grade Pro.

Welcome to Easy Grade Pro 3.5 from Orbis Software! With Easy Grade Pro, you will be able
to manage your student data with ease and effectiveness. Easy Grade Pro allows you to
create an electronic gradebook which, like a paper gradebook, can store student,
assignment, score and attendance data on all of your classes and subjects for a year. But
unlike a paper gradebook, an Easy Grade Pro gradebook provides an abundance of tools to
save you time, provides you with a wealth of information about your students, and allows you
to generate professional electronic and paper reports to effectively communicate your data
with others.

Welcome to
Easy Grade Pro

Macintosh: Easy Grade Pro requires System 7.0 or higher, a CD-ROM drive (to install the
software), a hard disk drive with 4 MB of free space, and 8MB of RAM for PowerPC
processor-based systems or 2.5 MB of RAM for non-PowerPC systems.

System Requirements

Windows: Easy Grade Pro requires Windows 95, 98 or NT, a color monitor with 256+ colors
with at least 640x480 resolution, a CD-ROM drive (to install the software), a hard disk drive
with 4 MB of free space, and 16 MB of RAM.
1 Install Easy Grade Pro.
Macintosh: Insert the installation CD-ROM. The icon of the disk will appear on the
desktop. Double-click the Easy Grade Pro 3.5 Installer icon and follow the steps.

Installing and
Registering
Easy Grade Pro
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Windows: Insert the installation CD-ROM. Choose Run from the Start menu. Type
D:\setup.exe and press enter. Note: use the drive letter for your CD-ROM drive in place
of the D.
During the installation process, the Easy Grade Pro application and a sample document
titled Demo Gradebook will be placed on the hard drive.
2 Eject the disk.
The Easy Grade Pro disk is used for installation only. Be sure to store it in a safe place.
3 Start Easy Grade Pro.
Macintosh: Double-click on the Easy Grade Pro™ 3.5 icon. This icon can be found in the
Easy Grade Pro folder created during installation.
Windows: Click on Start in the corner of your screen, point to Programs, point to Easy
Grade Pro and then click Easy Grade Pro.
4 Carefully type the serial number from the Installation card and click OK.

5 Carefully type the registration name and click OK.
The registration name will appear on all reports.
6 In the window that appears, click the Quit Easy Grade Pro button.
Easy Grade Pro will terminate. Be sure to store the registration number in a safe place in
case you need to reinstall Easy Grade Pro later. Be sure to complete the paper
registration card that is included with this package and mail it to Orbis Software.

How to use this
manual

This manual has been designed to be a reference tool rather than something that should be
read from beginning to end. You'll find simple, step-by-step instructions along with lots of
illustrations. You are encouraged to have this manual at hand as you learn to use the
program; the explanations and tips can save time and provide insight into what's going on.
Chapters 1-3: Getting Started
If you are new to Easy Grade Pro, you’ll save time by thoroughly investigating the first three
chapters. The rest of Chapter 1 lists the special features of Easy Grade Pro. Chapter 2,
“Getting Help”, explains how to quickly get answers to questions while you are using the
program. You’ll find several Quick Reference sheets. Chapter 3, “Tutorial”, should not be
missed; by spending time going through its short lessons, you’ll quickly discover how you
can use Easy Grade Pro with your classes and students.
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Chapters 4-7: Starting Your Own Gradebook
When you are ready to start your own gradebook, first take a look at chapters four through
seven. Chapter 4, “The Gradebook”, explains how a gradebook is structured and how to
create one. Chapter 5, “Options”, describes the variety of options available for each class and
for the gradebook. In Chapter 6, “Students”, and Chapter 7, “Assignments” you'll learn how
to add and work with students and assignments.
Chapters 8-9: The Charts
Before you start entering scores, be sure to look at Chapter 8, “The Score Chart” because it
describes a variety of ways to quickly enter scores. It explains how to add notes to scores,
how to add extra credit, how to curve and drop scores and how to override calculated grades.
If you will be working with attendance, seats or student record data, check out Chapter 9,
“The Other Charts” for explanations and suggestions about the four remaining charts.
Chapter 10: The Most Important Chapter
If you only read one chapter, it should be Chapter 10, “Security”. It is essential that you
follow a fail-safe plan for protecting your student data.
Chapters 11-14: The Other Chapters
Chapters 11 through 14 are available when needed. They cover summaries (Chapter 11,
“Summaries”), printing (Chapter 12, “Reports”), sharing electronic data with others
(Chapter 13, “Porting”) and how to use a gradebook on both Macintosh and Windows
computers (Chapter 14, “Working Cross Platform”). At the end you’ll find an appendix with
FAQs (frequently asked questions), technical support information and an index.
What you need to know...
This manual assumes that you have basic computer skills. Specifically, you should be able to -1) use the mouse to point, press, drag, click and double-click; 2) work with icons, folders, windows, buttons, scroll bars and
menus; and 3) save, open, rename and delete files. If you cannot do all of these, it is recommended that you read your computer
manual or other instructional materials before proceeding.

General Features
■
A single gradebook can contain virtually unlimited classes or subjects in up to ten terms.
■
In most cases, a teacher needs to create only one gradebook per year.
■
Each class has five main charts: scores, attendance, seating, student and assignment.
■
A single mouse-press is all that is needed to switch to any class or chart.
■
Comprehensive options and tools are available for each class and chart.

Easy Grade Pro
Features List

Student Features
■
A single class can have up to 1000 students.
■
Students can be added to a gradebook by typing and by importing from other software.
■
Student records can include numerous teacher-defined fields.
Grading Features
■
A single class can have up to 1000 assignments.
■
Grade scales can include letters, words and numbers and can be unique to each student.
■
Each class can have numerous score categories which can be weighted or unweighted.
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■
■
■

■
■
■
■
■
■

Scores can include numbers, percents, grades, symbols and words (satisfactory).
Scores can be entered in a variety of ways including typing, clicking and filling down.
Scores can be entered directly from unsorted student papers (even papers that are
mixed by class or subject) because Easy Grade Pro can quickly find the students for you.
Text can be used with scores or in place of scores.
Often-used text can be stored and reused. Text can include variables.
Footnotes can be attached to scores.
Scores can be dropped and curved.
Automatically calculated grades can be manually overridden.
Special columns can be set up to show data such as points earned, the number of
missing assignments, class rank, the percent change from the prior term and more.

Attendance Features
■ Up to ten master attendance categories (Absences and Tardies) can be used with up to
fifteen subcategories (excused and unexcused).
■ Partial-day absences can be recorded in addition to full-day absences.
■ Daily attendance can be exported over a network to school administration software.
■ Attendance can be taken using the attendance or seating charts.
Seating Chart Features
■ Seats can be designed using a variety of formats, sizes and colors.
■ Classroom furniture can be added using a variety of shapes, sizes and colors.
■ Seats and furniture can be rotated and located anywhere to match the real classroom.
Summaries and Reports
■ Summaries offer informative views into student and class performance.
■ Extensive textual notes and comments can be entered.
■ Variables which are automatically filled in with student data can be added to all text.
■ Nineteen comprehensive, customizable reports are available.
■ Most reports can include data from multiple classes or subjects.
■ Student reports can be printed in English, Spanish, French or a user-defined language.
■ Each report can be previewed onscreen.
■ Electronic reports can be created for use in web pages and as attachments to e-mail.
Other Features
■ A gradebook can be used on Windows and Macintosh platforms without conversion.
■ Students, assignments and seats can be sorted or repositioned by dragging.
■ Copy data tools allow you to easily copy any data from one class to other classes.
■ A 50,000-word dictionary is available to spell-check all text including student names.
■ Filters can be designed and used to display just the desired students and assignments.
■ Extensive porting tools allow you to exchange data with other programs.
■ Full editing on groups of scores, students and assignments is available in all charts.
■ In case of mistakes, undo is nearly always available to reverse the last action.
■ A tool bar and tool palette allow you to place often-used tools where you want them.
■ View tabs in nearly all windows make it easy to navigate through a gradebook.
■ Color, font, font size, column width and many other display features can be customized.
■ True file compression allows you to create large gradebooks that still fit on a floppy disk.
■ Other features include a TA mode, password protection, and an in-context help window.
1-4 GETTING STARTED

Chapter 2

Getting Help
Easy Grade Pro’s built-in help tools and Quick Reference sheets allow you to quickly get
answers to questions that may arise as you work. This chapter presents these tools.

The Easy Grade Pro application provides help in the form of balloon help, status bar help and
a context-sensitive help window.

How to get help while
working

Balloon Help (Macintosh)
Balloons are short descriptions that appear and disappear as the mouse arrow is moved
around in a window. Use balloon help whenever you need a quick description of an item.
Easy Grade Pro has balloons for tools on the tool bar, for regions in the main gradebook
window, and for buttons and objects in most other windows.
To turn balloon help on, click the Balloon Help tool found in nearly every window or choose
Show Balloons from the Help menu. When an object is pointed to with the mouse arrow, a
balloon will appear (like the one shown below). To turn balloon help off, select the tool
again or choose Hide Balloons from the Help menu.

Balloon Help Tool

Balloons can be very helpful because they are quick to provide information about specific
items.
Status Bar Help (Windows)
The status bar is a region at the bottom of the main gradebook window below the horizontal
scroll bar. It provides information about the tool, menu or region currently pointed to by the
mouse.
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To turn the status bar on, choose Show Status Bar from the Help menu. When an object is
pointed to with the mouse arrow, text will appear (like the text shown above). To turn this
help off, select the menu item again.

Help Window Tool

Help Window
Use the Help window whenever you need a detailed description or explanation on one of
Easy Grade Pro’s features. To open this window, click the Help Window tool or choose Easy
Grade Pro Help from the Help menu. The Help Window tool is found in nearly every
window. Easy Grade Pro will display information based on the window in which the tool is
clicked. The Help window has two views: Contents and Index (as shown).
Contents View

The Contents view displays information on a single topic. The Index view contains a list of
over 100 help topics. You can switch between the views by clicking the button in the lowerleft corner.
Index View

To search for some specified text such as drop (as in dropping scores), use the Find and
Again buttons. Searching works in either view.

The Quick
Reference Sheets
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The remaining pages of this chapter consist of several Quick Reference sheets. These
sheets can be used to get quick answers to your questions about menus, the tool bar and
the charts (scores, attendance, seating, and student). Orbis Software grants permission to
registered users to make copies of the Quick Reference sheets for personal use.

The Menus

• New... opens the Save window where
a new gradebook can be created.
• Open... opens the standard Open
window where an existing gradebook
can be opened.
• Close closes the gradebook.
• Save Copy... makes a backup copy
of a gradebook.
• Compress makes a gradebook
smaller.
• Import... brings in students,
assignments, etc. from another Easy
Grade Pro gradebook or TEXT file.
• Export... creates a file of gradebook
data to be used by another Easy
Grade Pro user or by another program.
It can be used to export a template for
new gradebooks.
• Print... opens the Print Reports window
where reports can be printed or saved
as disk files.
• TA Mode turns the Teacher Assistant
mode on and off. A check indicates
that the mode is on.
• Lock... locks the gradebook and
opens the Locked window for security.
• Exit/Quit closes a gradebook and
quits Easy Grade Pro.

• Undo reverses the last action. The
menu item's text indicates the last
action.
• Cut erases selected rows, columns
or text and places the data on the
Clipboard.
• Copy copies the selected rows,
columns or text and places the data
on the Clipboard.
• Paste copies the contents of the
Clipboard to your gradebook at the
insertion point.
• Clear erases selected data without
placing it on the Clipboard. Same as
the delete key.
• Class Options... opens a window
with options that affect the current
class.
• Gradebook Options... opens a
window with options that affect the
whole gradebook.
• Tool Options allows you to set the
display of tabs, tool bar and tool
palettes.
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• Copy... opens a window where students,
assignments, options, etc. can be copied from one
class to others.
• Add opens a window to the first empty class,
student or assignment record.
• Delete opens a window where classes, students
and assignments can be deleted.
• Fill repeats the selected text from the starting cell
down to the last row or across to the last column.
• Find allows you to search for a student or
assignment anywhere in the gradebook.
• Score Tools includes four items. Change Scores...
can be used to change all occurrences of a score,
such as blank, to another score, such as 0. Curve
Assignment... allows you to change the distribution
of grades on an assignment. Lock Grade... opens a
window where overall averages can be overridden.
Open Score Note... opens a window where text and
footnotes can be attached to a score.
• Seat Tools includes four items. Add Furniture can
be used to add one piece of furniture such as an
empty student desk. Seat Format... opens a window
where the format can be set for selected seats and
furniture. Rotate Left and Rotate Right are used to
rotate the selected furniture or seats 90°.
• Term Tools includes three items. Combine
Terms... opens a window where grades and
attendance data from prior terms can be copied to
and combined with the current class. Recombine
Terms should be used only if student grade or
attendance data in prior terms have been altered
and should be recopied to the current class. Start
New Term causes a new class with the same
students to be added to the gradebook.

*Permission granted by Orbis Software Inc. to registered users to make copies of this page for personal use only.

• Show All “unhides” all class data
except for students whose status is
WD (hidden).
• Show Selected hides all rows and
columns except those that are
selected. To select rows or
columns, press on the first row or
column number and drag to the last.
• Hide Selected hides all selected
rows or assignment columns.
• Filters can be used to show and
hide the desired rows, columns and
scores. Several filters are included.
To create or edit filters, use the last
item in the sub-menu.
• Sort Assignments. Assignments
can be sorted by date, category or
name.
• Sort Seats. Seats can be sorted
randomly or by a variety of patterns.
• Sort Students. Students can be
sorted using a variety of rules.
• Sort Classes... opens a window
where classes can be rearranged
into any order.

• Score, Attendance, Seating,
Student, and Assignment
Charts. Use these items to
switch between the five charts in
a gradebook. A check indicates
the current view.
• Records... opens a window where
class, student and assignment
records can be viewed and
edited.
• Summaries... opens a window
where comprehensive class,
assignment and student
summaries can be viewed.
Comments and extensive notes
can be prepared.

• Next switches to the next class
within the current term.
• Prior switches to the prior class
within the current term.
• Quarter 1 and 2 allow you to
switch to any class in the
gradebook. A check indicates the
current class.

The Tool Bar

Display of Grades
Use this menu to set the
display of grades and special
scores and to set the typing
mode.
Show/Hide Grades
Press on this triangle to show
or hide the row of grades and
scores along the bottom of
the tool bar.
Moving Tools
To move a tool, press on it
and drag it to the new location
on the tool bar.
Changing Tools
To change a tool, press and
hold on a tool until a menu
appears. Select the new tool
from the menu.
Removing Tools
To remove a tool, press and
hold on the tool until a menu
appears. Select Blank tool
from the menu.
Small Monitors (Macintosh)
The tabs and tool bar are not
available on monitors with
resolution less than 640 x
480.
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Add Assignment
Opens the Records window to the first
empty assignment record.

Fill Across
Repeats the selected data across
a row to the last column.

Print
Opens a window where reports
can be printed or saved as files.

Add Furniture
Adds a piece of furniture to the
seating chart.

Fill Down
Repeats the selected data down a
column to the last row.

Prior Class
Switches to the prior class in the
current term.

Add Student
Opens the Records window to the
first empty student record.

Filters
Opens a window where filters can
be viewed and edited.

Prior Term
Switches to the prior term for the
current class.

Balloon Help (Macintosh)
Turns Balloon Help on and off.

Find
Opens a window where search
text can be entered.

Records
Opens a window with class,
student and assignment records.

Change Scores
Changes all occurrences of a
certain score to another score.

Find Again
Finds the next matching student
or assignment.

Rotate Seat
Rotates the selected furniture 90°
clockwise.

Class Options
Opens a window where class
options can be edited.

Help Tool
Opens a window with help on over
100 topics.

Save Copy
Makes a backup copy of the
current gradebook.

Copy Class Data
Opens a window where data can
be copied to other classes.

Lock Gradebook
Locks the gradebook and opens
the Lock window.

Sort
Sorts students, assignments and
seats based on the current chart.

Curve Scores
Opens a window where the spread
of scores can be changed.

Next Class
Switches to the next class in the
current term.

Summaries
Opens a window with extensive
summaries.

Delete
Deletes the selected scores,
students, assignments, seats, etc.

Next Term
Switches to the next term for the
current class.

TA Mode
Turns the TA mode on and off.

Export Attendance
Exports one day’s attendance
data to a text file over a network.

Open Score Note
Opens a window where text can
be entered about a score.

Undo
Reverses the last action.

*Permission granted by Orbis Software Inc. to registered users to make copies of this page for personal use only.

The Score Chart
Display Columns
To add, delete or change the
contents of a column, press
on the column title. To resize
a column, press and drag the
vertical line after the title.

Filtering Assignments
To show some or all
assignments, press here. When
only one item is displayed, the
horizontal scroll bar scrolls one
assignment at a time.
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Viewing Records
To view or edit the record for
an assignment, double-click
on its title. Alternate: click on
the assignment’s title and
select the Records Tool.

Viewing Summaries
To view the summary for an
assignment, double-click on its
column number. Alternate:
click the assignment’s title and
select the Summaries tool.

Relocating Columns
To relocate an assignment,
press on the assignment’s title
and drag the column left or
right to the new location.

Editing Columns
To select a column (or
columns), press on the
number (and drag left or right).
Then choose Cut, Copy,
Clear or Paste from the Edit
menu.

Filtering Students
To show one or all students,
press here. When only one
student is displayed, the
vertical scroll bar scrolls one
student at a time.

Custom Filters
To apply a custom filter (such
as Show Missing Work), use
this menu.

Viewing Records
To view or edit the record for a
student, double-click on the
student’s name. Alternate:
click on a student’s name and
select the Records tool.

Adding Assignments
To add a new assignment,
click here. If the assignment
is already in another class,
use the Copy Class Data
Tool instead.

Viewing Summaries
To view the summary for a
student, double-click on the
row number. Alternate: click
on a student’s name and
select the Summaries tool.

Title Height
To change the height of the
assignment titles, press on
this line and drag up or down.

Relocating Rows
To relocate a student, press
on the student’s name and
drag the row up or down to the
new location.

Score Note
Double-click to open the
Score Note window. A small
square or notebook page
indicates a note.

Editing Rows
To select a row (or rows),
press on the row number (and
drag up or down). Then choose
Cut, Copy, Clear or Paste
from the Edit menu.

Adding Students
To add a student, click here. If
the student is already in
another class, use the Copy
Class Data Tool instead.

Moving Columns
To move a column to a new
location, press anywhere on
its data and drag left or right.

*Permission granted by Orbis Software Inc. to registered users to make copies of this page for personal use only.

Symbols
A padlock indicates an altered
grade. Click on the grade to
open the Lock Grade window.
An M indicates missing work.

Dropped Scores
A small d indicates that the
score has been dropped.
Assignments are set as Can
be Dropped in the Records
window.

Score Footnotes
Double-click to add a footnote.
Alternates: type a number from
0 to 7 while pressing option
(Macintosh) or alt (Windows).

The Attendance Chart
Attendance Marks
Click here to show or hide a
row of attendance codes.
These codes can be clicked
when entering student
attendance data.

Mini-Summary
The mini-summary can be
used to show attendance totals
in all categories for the
selected student.

Filtering Days
To show some or all days, press
here. When only one day is
displayed, the horizontal scroll
bar scrolls one day at a time.
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Showing One Day
To show a single day only,
click on its title. Click on it
again to show all days.

Exporting Attendance
Use the Export Attendance
tool to save the one day’s
attendance marks anyplace
on a network.

Display Columns
To add, delete or change the
contents of a column, press
on the column title. To resize
a column, press and drag the
vertical line after the title.

Custom Filters
To apply a custom filter (such
as Hide Absent students), use
this menu.

Filtering Students
To show one or all students,
press here. When only one
student is displayed, the
vertical scroll bar scrolls one
student at a time.

Title Height
To change the height of the
date titles, press on this line
and drag up or down.

Viewing Records
To view or edit the record for a
student, double-click on the
student’s name. Alternate:
click on a student’s name and
select the Records tool.

Entering Attendance Data
To enter attendance data,
simply click on a cell. Then
type the attendance code or
click on a code in the tool bar.

Viewing Summaries
To view the summary for a
student, double-click on the
row number. Alternate: click
on a student’s name and
select the Summaries tool.

Attendance Note
Double-click to open a
student’s Note window where
attendance notes can be
entered.

Editing Rows
To select a row (or rows), press on
the row number (and drag up or
down). Then choose Cut, Copy,
Clear or Paste from the Edit menu.

Relocating Rows
To relocate a student, press
on the student’s name and
drag the row up or down to the
new location.

Adding Students
To add a student, click here. If
the student is already in
another class, use the Copy
Class Data Tool instead.
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Editing Attendance Data
To select attendance cells, click
on the first cell and drag to the last.
Then choose cut, copy, clear or
paste from the Edit menu.

No-school Days
The grayed attendance cells
indicate days set as noschool days in the Class
Options window.

The Seating Chart
Attendance Codes
Click here to show or hide a
row of attendance codes.
These codes can be clicked
when entering student
attendance data.

Seat Options
To open the Class Options
window where the format and
function of a seat can be set,
click the Class Options tool.
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Attendance Notes
To record an attendance note, first
select the student’s seat, then click
here. Or option-click (Macintosh) or
control-click (Windows) the seat.

Copying a Seating Chart
Use the Copy Class Data tool to
copy a seating chart and/or
furniture from one class to others.

Adding Furniture
To add an empty student desk
or a piece of classroom
furniture, click this tool.

Entering Attendance Data
To enter attendance data,
simply click on the arrow on a
seat and choose the code. Or
click on the seat and click on
the code in the tool bar.

Exporting Attendance
Use the Export Attendance
tool to send one day’s
attendance data anyplace on
a network.

Selecting Items
You can select items by
clicking, by shift-clicking or
by dragging a rectangle
around a group of items.

Rotate Seat
Use this tool to rotate all
selected seats or pieces of
furniture 90° clockwise.

Swapping Seats
To swap two seats (or a group
of seats), drag the first seat to
the top-left corner of the
second seat.

Resizing Furniture
To resize a piece of furniture,
drag the small box in the
lower-right region.

Set the Attendance Date
Use this button to open a
window where the attendance
date can be set to any date
within the class calendar.

Attendance Date
This displays the date for
which any attendance marks
on the seats apply. Grayed if
not the current date.

Prior/Next Date Buttons
Use these buttons to change
the attendance date (shown on
the left) to the prior or next day.
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Format Options
Double-click on a seat or piece
of furniture to open a window
where you can set the title,
shape, color and rotation.

Editing Furniture
Choose Cut, Copy, Paste or
Clear from the Edit menu, to
edit any selected pieces of
furniture. You can also use the
delete key to remove furniture.

The Student Chart
Filtering Students
To show one or all students, press
here. When only one student is
displayed, the vertical scroll bar
scrolls one student at a time.
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Relocating Columns
To change the order of the
columns, press on a title and
drag it left or right.

Resizing Columns
To resize a column press on the
vertical line to the right of the title.
Then drag the line left or right.

Viewing Summaries
To view the summary for a
student, double-click on the
row number. Alternate: click
on a student’s name and
select the Summaries tool.

Custom Filters
To apply a custom filter (such
as Show Improving students),
use this menu.

Relocating Rows
To relocate a student, press
on the student’s name and
drag the row up or down to the
new location.

Custom Labels
To rename any of the twelve
custom column labels,
double-click on any cell. A
window will open where
editing can occur.

Editing Rows
To select a row (or rows),
click on the row number (and
drag up or down). Then
choose Cut, Copy, Clear or
Paste from the Edit menu.

Viewing Records
To view or edit a student’s
record, double-click anyplace
on a row (except in columns
with menus). Alternate: click
on a student’s name and
select the Records tool.

Adding Students
To add a student, click here. If
the student is already in
another class, use the Copy
Class Data Tool instead.

Menus
When selecting a cell in the ID,
Status, Language or Grade Scale
columns, menus appear allowing
you to select the cell data.
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Editing Column Data
To edit column data, click on the first cell
and drag to the last. Then choose Cut,
Copy, Clear or Paste from the Edit menu.
(You cannot edit multiple columns.)

Chapter 3

Tutorial
The four lessons in this chapter are meant to introduce you to the structure, tools and options
found in Easy Grade Pro. The word to remember is explore; these lessons are meant only to
be springboards for your own study of the program.

1 Open the gradebook titled Demo Gradebook.
Macintosh: Double-click on the icon titled Demo Gradebook (not the Easy Grade Pro
icon) found inside the Easy Grade Pro Folder.
Windows: Click on Start in the corner of your screen, point to Programs, point to Easy
Grade Pro and then click Demo Gradebook.

Lesson 1: Moving
around a Gradebook

After clicking, Easy Grade Pro will display its title window and then the gradebook
window will appear as shown.
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This is the gradebook of a fictitious sixth grade teacher, Ms. Demo, who teaches Reading,
Math, Language Arts and Science. She also teaches science to the students in the other sixth
grade class. The homeroom teacher of those students teaches Social Studies to both
classes. Ms. Demo is currently in the second quarter of the school year and you are viewing
the score chart for the class Quarter 2: Reading. Notice that the name of this class is on the
Class menu below the tabs. Macintosh: If you are using Easy Grade Pro on a computer with
a small monitor (less than 640 x 480 resolution), then you will see a tool palette instead of a
tool bar and tabs.
Press here

2 Use the Class menu on the tool bar to switch to Quarter 2: Math.
Notice that Ms. Demo's math class has most of the same students as her reading class
but the assignments are different.
3 Use the Class menu to move to Science-1 and then to Science-2.
Remember that Ms. Demo teaches science to both sixth grade classes. The science
classes have the same assignments but different students. By the way, Ms. Demo enters
assignments into just one class and then copies them to the other class.
4 Move to the Social Studies class to view a class imported from the other
sixth grade teacher's gradebook.
Notice that the students are the same but several items are different. Ms. Demo does
not teach this class -- it is taught by an associate. But Ms. Demo wants to keep track of
her students’ performance in all classes and wants to include their Social Studies grades
in the progress reports sent to parents. So, periodically, she imports (either by floppy
disk or directly over a network) the entire Social Studies class from her associate's Easy
Grade Pro gradebook.
Facts about Classes
An Easy Grade Pro gradebook can have hundreds of classes. A class can have up to 1000 students and 1000 assignments. Each
class has a unique set of options called Class Options that includes everything from grade scales, categories and special scores
to calendars, seat format and colors.

Before moving to the next step, you may wish to explore a bit further by moving to other
classes in the gradebook and terms in the gradebook. When you are ready to move on, use
the menu on the tool bar to return to Quarter 2: Reading.
5 Click on the Attend. tab to switch to the attendance chart.
You can also switch charts using the Chart menu.
Press here
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Notice that the new chart displays dates and attendance marks. Ms. Demo takes
attendance in just one class, Reading, because it is the first class. A class has five charts:
score, attendance, seating, student and assignment.
6 Use the tabs (or Chart menu) to view all five charts.
Before moving to the next lesson, you may wish to explore the five charts in other
classes to see how each class has been set up.
Probably the most time consuming task in the grading process is that of adding assignments
and scores. Easy Grade Pro provides many tools to make this task easy and fast. In this
lesson, you'll be introduced to some of these tools. To begin this lesson, the Demo
Gradebook must be open and the score chart must be visible.

Lesson 2: Adding an
Assignment

1 Using the Class menu, move to Quarter 2: Science-1.
You'll know that you are in this class when its title is visible on the tool bar. Macintosh: If
you are using Easy Grade Pro on a computer with a small monitor (less than 640 x 480
resolution), then you will see a tool palette instead of a tool bar.
2 To prepare for the entering of scores, click the small triangle below-left of
the first tab so that the triangle points downwards.
The triangle (circled below) shows and hides a row of grades and special scores. (Note:
if the tool bar is visible instead of the tool palette, this triangle is not available.)

3 Click the Add Assignment button after the last assignment.
After clicking, the Records window will open to the first empty assignment record.

4 In the Name field, type Star Lab.
The box should already have a flashing cursor in it. If not, press the tab key as needed
until the flashing cursor is in the box. If you make a mistake while typing, press the
delete key.
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5 Press tab to move to the Max. Score field. Type 25.
The maximum score is the score that earns a 100%. On this assignment, a student that
earns a score of 25 will receive a 100%.
6 Press tab to move to the Points field. Type 100.
Points refers to the value or weight of the assignment. Ms. Demo uses 100 on any
assignment that has a normal value. She uses a higher number for more important
assignments and a lower number for less important assignments.
7 Set the due date of the assignment on the calendar.
The date is used by Easy Grade Pro when sorting, using filters and producing graphs.
8 Press on the Category menu and select Classwork.
The category is used when sorting assignments, when using filters and in graphs and
reports. You may wish to view the other menus to see what choices are available.
9 Click the Done button.
You should be viewing the score chart again. The first score cell under the new
assignment's title should have the flashing cursor in it. If not, click on the first empty box
under the Star Lab assignment. Now it's time to enter scores. Just to make things
interesting, you'll enter scores in several different ways.

Fill Down Tool

Undo Tool

10 Enter the scores for the ten students as follows:
(If you make a mistake, simply click on the score cell with the error and try again.)
Student #1: Type the number 25 and press enter.
Student #2: Click on the B grade on the tool bar. Do not push the enter key because the
next cell is automatically selected after clicking. You can set up the grades
that appear on the tool bar. In fact, you can have a different set of grades for
each student.
Student #3: Press the letter m. This enters a score of mi for missing. You can customize
up to thirty special scores and give them any meaning you wish.
Student #4: Type the number 25. Do not push enter. Now click the Fill Down button on
the tool bar. Notice that 25 is repeated all the way down.
11 Click the Undo tool on the tool bar to prepare for the next step.
Notice that the score of 25 is removed from the students. Undo is nearly always available
to reverse the last action. Next, you'll enter these student’s scores in a different way.
12 Select the seven blank score cells by pressing on the first and dragging to
the last one. Then release the mouse.
The seven score cells should be highlighted as shown below.

Press on this cell.

Drag to this cell.
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13 Click on the A+ grade on the tool bar.
A score of 25 is entered for each student. Try clicking on other grades in the tool bar.
Recall that Ms. Demo teaches two science classes and both have the same assignments. It is
easy to copy assignments from one class to another. In the next few steps, you'll do just that.
14 Using the Class menu on the tool bar, move to Quarter 2: Science-2.
The class will be displayed as usual. Be sure to move to Science-2 and Quarter 2.
15 Click on the Copy Class Data tool.
The Copy Class Data window will open.

Copy Class Data Tool

The Copy Window
The Copy window can be used to copy assignments, students, options and other class data. It can copy several items together
and copy them to several classes at the same time.

16 First click on the Assign. tab at the top. In the top-left list, click on
Quarter 2: Science-1. In the bottom-left list, click on Quarter 2: Science2. In the right-hand list, click on Star Lab. Finally, click Copy.
The assignment will be copied from Science-1 to Science-2. After the window closes,
the first score cell for the new assignment will be selected, ready for you to enter scores.
The rest of this lesson will focus on entering scores for the copied assignment. You'll use a
very powerful tool that allows you to easily enter scores from a mixed stack of papers. Since
you don't actually have the student papers, you'll simply pretend. Keep in mind that the
more students and papers there are, the more powerful this tool becomes.
17 Click on the Find tool to open the Find Window.

Find Tool
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18 In this window, select Use Continuous Search Mode. Then click Exit.
The continuous search mode causes Easy Grade Pro to return to this window after every
score is entered. This means that whenever the enter key is pressed, or whenever a
grade is clicked on the tool bar, the Find window will reappear.
19 In the score chart, select the first score cell for the Star Lab assignment.
This score cell is for Kelly Armstrong. The cursor should be flashing in this score cell.
20 You will be pretending to enter scores directly from student papers.
Follow these steps:
Paper #1:
Paper #2:
Paper #3:
Paper #4:

In Kelly Armstrong's score cell, enter a 25 and press enter. The Find window
will reopen.
The next paper belongs to Josef Talbo. In the Find window, type the letter T
and notice that Easy Grade Pro completes it with “Talbo, Josef”. Press enter.
Now click Sat on the tool bar. The Find window reopens.
Tad Nguyen earned a 20. Type an N in the Find window and press enter.
Type a score of 20 and press enter again.
Justin Bronin earned an 18. Type the letter B and notice that Easy Grade Pro
completes it with ‘Benjamin, Atunde’. Type the letter r and notice that Easy
Grade Pro completes it with ‘Bronin, Justin’. Press enter. Type his score.

Go ahead and finish the remaining scores on your own. When you are done, be sure to
deselect the Use Continuous Search Mode box (so the Find window will stop reappearing)
and click Exit. The Find window can be used to enter papers even when those papers are
mixed by class. By setting the option Search through all current-term classes, Easy Grade
Pro will search in other classes if the student is not found in the current class.
Macintosh: By the way, there is a second way for quickly jumping to any student in a class.
Try this: hold down the control key and press the letter G. Easy Grade Pro instantly
highlights the student Rachel Gunderson.

Lesson 3: Options
and Tools

This lesson, which has been divided into five short parts, will guide you in an exploration of
some of the options and tools within a gradebook. To begin this lesson, the Demo
Gradebook must be open.
Part A: Gradebook and Class Options
Easy Grade Pro offers an abundance of options to accommodate your personal style. Some
options, such as font and font size, affect the entire gradebook and are called Gradebook
Options. But many options apply only to a single class; these are called Class Options and
include items like grade scales, categories, weighting, calendars, colors and more. In this
section, you’ll view and edit both types of options.
1 Select Gradebook Options from the Edit menu and explore.
Use the tabs to switch between the views. Gradebook Options can be changed at any
time. When you are finished, click the Done button
2 Select Class Options from the Edit menu and explore.
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Use the tabs to switch between the views. Most Class Options can be changed freely.
When you are finished, click the Done button.

Part B: Adding a New Data Column
Easy Grade Pro provides numerous ways to configure the charts so that they best suit your
needs. For example, in the score chart, columns can be added which show class rank, points,
or nearly any other data about your students. The next few steps show you how to do this.
1 Switch to the score chart view of Quarter 2: Reading.
Press here

2 Above the column of student names, press on the 11 of 11 Students title.
While pressing, a menu will appear.
3 From the menu, choose Add NEW Column (first item).
A new column will appear to the immediate right. It will also be titled 11 of 11 Students.
4 Press on the new column’s title and choose Class Rank.
The title and content of the column will change to display the rank for each student.
Since the column is much wider than needed, in the next step you’ll make it narrower.
5 Move the mouse so that the arrow is over the line to the right of the Class
Rank title. Press and drag the line to the left.
After releasing the mouse, the column will be set to the new size. You can have up to
eight display columns with the content, width and position of your choice in both the
scores and attendance charts.

Press here

Moving Students, Assignments and Data Columns
Students, assignments and data columns can easily be moved to any row or column. Simply press on the student’s name, on
the assignment’s title or on the data in a data column. The cursor will change to a hand. Then drag the row or column to the
new position and let go. Easy Grade Pro will push the items down or to the right to make room.

Part C: Using Filters
Easy Grade Pro allows you to configure the charts so that they display just the students,
assignments, scores or attendance dates that you want to see. For example, the score chart
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has four small menus that allow you to control display. These have been circled in the
illustration below. Similar menus are found in nearly every chart. In this section, you will
explore these four menus to discover what they do.
1 Switch to the score chart in any class and explore the display menus.
Note that in the right-most menu, the last item allows you to open a window where you
can design your own filters. You may wish to take a moment to try this.
2 Switch to the other charts (except seating) and explore the display
menus.

Part D: Setting the Display of Seats and Furniture
The seating chart allows you to place seats and furniture nearly anywhere. It also allows you
to change the shape, size, rotation and color of these items. Use the Chart menu or tabs to
switch to this chart. Then try these:
■ Move a single item by dragging it.
■ Swap two seats by dragging one to another. (The upper-left corners must be aligned.)
■ Select more than one item by clicking while holding down the shift key or by dragging a
rectangle around the seats.
■ Drag a group of selected items.
■ Double-click on a seat to open the Seat Options window. Try setting different options.
■ Double-click on a piece of furniture to open the Furniture Options window.
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Part E: Other Tools and Windows
Many special windows can be opened by double-clicking in different regions of a chart. Try
these suggestions for opening windows from the score chart:
■
Double-click on any row number to open the Summaries window for that student.
■
Double-click on any column number to open the Summaries window for that
assignment.
■
Double-click on any score cell to open the Score Note window.
■
Double-click on any student or assignment name to open the Records window.
■
Single-click in the small box before the first score to open the Lock Grade window.
In this lesson, you will be taken through the steps of selecting one report, its range and
options. Then, instead of printing the report, you will preview the report on screen. The
Demo Gradebook should be open and visible. You can be in any class within the gradebook.
1 Click the Print tool on the tool bar or choose Print from the File menu.
After clicking, the Print Reports window will open. Notice that there are three tabs with
nineteen reports. To get a description of a report, click on the help tool.

Lesson 4: Working with
Reports

Print Tool

2 Select the Single-class Progress item and click Next.
After clicking Next, the Report Options window will open. The Report Options window
allows you to set the items to be included, set options, preview reports and then print
the reports to paper or disk. There is a different window for each report.

3 Set the range and options as desired.
The upper half of the window allows you to select the students to receive reports. The
lower half of the window allows you to select the items to be included in each report.
Click the set buttons to open windows where additional options can be set. Click the
Page/Print Setup button to set options based on your current printer. To get a
description of an option, click on the help tool.
4 Click the Preview button.
The Print Preview window will open showing exactly how the report will appear on paper
or in the disk file. The Print Preview window has two views: fit-in-screen and full-size
views. The fit-in-screen view shows the entire page. Depending on the size of your
monitor, the details on the page may be unreadable. In this view, the cursor is a
magnifying glass. By clicking once on any part of the page, the view automatically
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switches to the full-size view.

The full-size view shows the page at its actual size. In this view, the cursor becomes a hand.
By pressing the mouse button, the page can be grabbed and dragged about. Double-clicking
causes the view to change to the original view. The Zoom button can also be used to toggle
between the two views.
5 Switch between the two views using the Zoom button or by clicking and
double-clicking on the page. Click the Next Page button to switch pages.
Practice clicking with the magnifying glass to zoom in to the desired part of the report.
When the hand cursor is visible, practice dragging the page about. Then double-click to
return to the normal view.
6 Click the Done button to close the Print Preview window.
If you like, change any options in the Report Options window, then preview again to see
how the report has changed.
7 Click the Cancel button in the Report Options window.
The Report Options window will close.
If you'd like, repeat the steps in this lesson for other reports. It's easy. All the reports have
options which allow much customization. Several reports (graphs, seating chart) can be
printed in color. When you are done, click the Cancel button.
◆ This is the end of Lesson 4 and the end of this chapter. You can quit Easy Grade Pro by
choosing Quit/Exit from the File menu. By the way, all changes that you made during
these lessons have been automatically saved. With Easy Grade Pro, changes are always
automatically saved!
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Chapter 4

The Gradebook
A teacher preparing a paper gradebook must obtain the gradebook and write the names of
classes or subjects on its pages. In starting an electronic gradebook using Easy Grade Pro, the
same is essentially done: a gradebook file must be created and the names of classes or subjects
must be added to it. This chapter first explains the structure of a gradebook. It then shows
how to create a gradebook with classes and how to perform basic gradebook management.

An Easy Grade Pro gradebook is a document or electronic file that holds two types of
structures: 1) a set of options known as gradebook options and 2) one or more classes each
of which consists of student records, assignment records, scores, attendance data, text and a
set of options known as class options. Although each class in a gradebook is distinct, any data
in one class can easily be copied to other classes.

The structure of a
gradebook

Gradebook Options
My Gradebook

One or more classes

student records
assignment records
scores
attendance
text
Class Options

Since a single gradebook can hold over 1000 classes in ten terms and each class can contain
up to 1000 students and 1000 assignments, a single gradebook can accommodate virtually
any teacher’s yearly schedule. Although you can create more than one gradebook, it is usually
best to use a single gradebook for a year or for a major grading period because it saves time
and minimizes duplication of efforts. For example, by using a single gradebook, you’ll have
access to any class or subject with a single menu selection. If you teach many subjects or
groups of students and record a lot of student data, you should be aware that a gradebook
can grow to be 1 MB in size or larger as the year progresses. If you intend to use a floppy
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disk to transfer or store a gradebook backup, you may find that your gradebook won’t fit on
the disk as is. New with Version 3.5 is a compression tool that can shrink a gradebook to
about one-third its uncompressed size.
Unless you have special circumstances, it is recommended that you start with a single
gradebook and not begin a new one until the year or a major grading period has ended.
Besides, you can always divide a gradebook into smaller gradebooks later.

How to create a
gradebook

1 Start Easy Grade Pro. If a gradebook opens, choose Close from the File
menu.
After a few seconds, a small window will appear (shown below).

2 Click the Create a New Gradebook button.
After clicking, the standard Save dialog will open. The appearance of this window varies
with the operating system your computer is running. This window allows you to do two
things: 1) type a name for your gradebook and 2) set the location for your gradebook.
3 Type the name of your new gradebook.
In most cases, the name you type should not be the name of just one class. Easy Grade
Pro displays a suggested format in the text box. To change it, simply type the new name.
4 Choose the location of your new gradebook.
It is strongly recommended that you save your gradebook to the hard disk of a computer
(or to some other reliable media) and not to a floppy disk. (See Floppy Disk Alert!
below).
5 Click the Save button.
The new gradebook will be saved and a window will appear showing the gradebook. The
icon for your new gradebook is a notebook with a large check mark on it.
My Gradebook

Floppy Disk Alert!
It is strongly recommended that you never use an Easy Grade Pro gradebook directly from a floppy disk. Not only is a floppy
drive very slow, it is not always reliable, especially when a floppy disk is used at two or more computers. Slight variations in the
speed, alignment and track width of the different floppy disk drives can cause a floppy disk that was working fine at one
computer to report an error at another computer. If you must use floppy disks, it is recommended that you use the floppy disk
only to store a gradebook or to transfer a gradebook from one computer’s hard drive to another. In all cases, make regular
backups.
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1 Open the Records window to the first blank class record.
If your gradebook has no classes, a window (shown below) will automatically appear.
Unless you are instructed otherwise, click the Add Classes button.

How to add classes

If your gradebook already has classes, choose Add Class from the Tool menu. In either
case, the Records window will open (shown below).

2 Type the name of the class in the Class/Subject Name field and press tab.
Be sure to use a unique name for the class. Examples include Math, Reading, English(1),
English(2), etc. Do not include a term name with the name of the class.
3 (Optional) Edit the Class Weight and press tab.
Class weight is used in some reports when a student’s weighted average for several
classes is calculated. In most cases it should be kept at 1.00. If you have a class that is
worth half of a normal class, set the class weight to 0.50 and so on.
4 (Optional) Edit the Term Labels.
Any of the term labels can be changed. You can use First 6 Weeks, Semester 2, etc. If
you will give a final exam that must be weighted, then you must add the final exam as a
term. Changes made to these labels will apply to all classes.
5 Select the desired terms.
A check mark will appear for each term that you select. You must select at least one term
but it is best to select all terms for which this class is taught.
6 (Optional) Edit the Custom Labels and add Custom Data.
There are eight custom text fields. You can set the labels of these fields as well as enter
any kind of information. You might put section number, room, meeting times, etc.
Changes made to these labels will apply to all classes within a gradebook, but the data are
unique to each class.
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7 (Optional) Add more classes.
To add more classes, click the Next Class button or press enter.
8 Click Done to close the Records window.
The new class names have now been placed in the Class menu which is used to switch
to the classes in a gradebook.

How to make changes
to a class record
Records Tool

How to view classes

At any time, you can view, edit or add data to a class record. You may wish to add a new term,
change the name of the class, add custom class data or make some other changes. You can
change nearly any data in a record. To make changes, choose Records from the Chart menu
or click the Records tool. Click the Classes tab and make the desired changes.
If a gradebook has classes, the Class menu can be used to view any class. There are actually
two Class menus; one is found on the tool bar (or tool palette) and the other is found at the
top with the other main menus. It makes no difference which is used.
Press here

How to save changes

How do you save changes? The answer is “You don’t!” Easy Grade Pro automatically
saves all changes to your gradebook. You never need to choose Save. Besides, there is no
Save command, only Save Copy.... which is used to make backup copies of your gradebook.
Automatic saving occurs whenever you switch classes, switch charts, print reports, open
windows and more. Typically, no more than just a few minutes elapse before Easy Grade Pro
automatically saves your work.

How to change the
order of classes

The order of the classes in the Records window determines the order in which the classes
appear in the Class menu and in reports. If you need to change the order of classes, begin by
choosing Sort Classes from the View menu. The Sort Classes window will open. To change
order, press on a class and drag it to the new location. Use the sample Class menu at the top
of the window to view the effects of your change.
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Chapter 5

Options
Easy Grade Pro attempts to accommodate the variations in how teachers manage student
data by providing options on two levels: class as well as gradebook. Class options apply only to
a specific class; gradebook options apply to the entire gradebook. This chapter explains how
to view and edit these options and how to copy class options from one class to others. At the
end, you’ll learn where to find options for some special tools including the tool bar and tabs.

Each class within a gradebook can have its own grading scales, rounding level, score
categories, special scores, attendance categories, calendar settings and other options.
Together, these are known as Class Options because they are stored with the class and are
unique to it.

What are Class
Options?

A class has no options until it is viewed for the first time. Easy Grade Pro automatically copies
a set of options into the class. It will first try to copy options from a related class in the
gradebook. For example, if you are entering the class Quarter 3: Math for the first time, Easy
Grade Pro will try to copy options from Quarter 2: Math. If it can’t find a related class, it will
try to copy the options from another class.
What happens if there is no class from which to copy options? In this case, Easy Grade Pro
will copy options from a built-in set. Then it will display a window (shown below) and ask if
you want to view the options. Since there is not much chance that the built-in options are
what you want, whenever you see this window you should select the View/Edit Class
Options button.
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Setting Class
Options

Class Options can be viewed and edited at any time. This section explains in general how to
do so. Explanations on specific options can be found in the sections that follow.

Class Options Tool

1 Open the Class Options window.
You can open this window in three ways: 1) by clicking the View/Edit Class Options
button (shown on the prior page), 2) by clicking the Class Options tool on the tool bar, or
3) by choosing Class Options from the Edit menu.
2 Select the desired option view.
To view the different options, press on the tabs at the top of the window. Note that
Term options are only available for classes after the first term. Macintosh: Color options
are only available on computers with at least 16 colors.

3 View or edit the options.
Each window has its own set of instructions. In general, you should use the tab, up arrow
and down arrow keys to move from one text field to another. Use the delete key to
erase any selected text. Extensive help is available by clicking the two help tools.
4 When you are ready to exit this window, click Done or Cancel.

Important Note...
Any changes that you make to the Class Options in one class have no effect on other existing classes. However, it is easy to
copy options from one class to other classes. To do so, choose Copy Class Data from the Tool menu.

Setting Grade Scale
Options

A grade scale is used by Easy Grade Pro to convert a student’s percent to some meaningful
label or grade. It consists of one or more grades with a minimum or cutoff percent for each.
Grades can be letters (A,B,C), words (Outstanding, Satisfactory) or numbers (4.00, 3.00).
Easy Grade Pro allows you to have multiple grade scales in a class in case you have students
that are to be graded differently based on ability or status. The first grade scale in the list is
the most important one because it is initially assigned to all students.
■
■
■

5-2 OPTIONS

Grade scales can be viewed and edited only in the Class Options window.
Grade scales can be put into any order by pressing on the row numbers and dragging.
Use the Records window or student chart to change a student’s assigned scale.

■
■
■
■
■

To edit a scale, first click on its row number. Then edit the grades and percents.
The minimum percents must be in descending order and the last percent must be 0.
Use the small blue arrows to insert or delete a row anywhere in a scale.
Use the tab, up, and down arrow keys to move from one text field to another.
Use the small blue arrow above the column of percents to open a window where the
grade click values for the scale are set. These are explained in the next section.

Easy Grade Pro allows you to click on grades on the tool bar (or tool palette) to enter scores
into score cells. It also allows you to type grades directly, but only if the Allow typing of
Grades and Special Scores option is turned on in the Gradebook Options window.

Setting Grade Click
Percents

An important question is, what percent does a student get when a grade is clicked or typed?
Not the minimum percent for the grade. The answer is that Easy Grade Pro uses 100% for
the top grade and, for all others, it uses the average percent for the grade. For example, if
you enter a B and a B ranges from 80 to 90%, the grade click value is 85%.
■
■
■

Grade click values are automatically set and editing is usually unnecessary.
To edit them, click the top blue arrow in the Class Options window (Scale tab).
Grade click values are always reset when changes are made to a grade scale.

Rounding options include whole numbers, tenths and hundredths, and are used whenever
percents are calculated. As an example, suppose a student has earned 89.638%. After
rounding, the number displayed will be 90% for ones rounding, 89.6% for tenths rounding
and 89.64% for hundredths. Rounding can be edited only in the Class Options window.

Setting Rounding
Options

Whenever an assignment is added to a class, a score category must be selected. Categories
are used in graphs, summary charts, filters and reports, to help provide useful information
about a student’s performance. A class can have up to fifteen score categories.

Setting Score
Category Options

■
■
■

■

Score Category options can be edited only in the Class Options window.
Since each class has its own set of options, you can use subject-specific names.
Score Category options can be changed at any time but be careful if the category is
already being used by an assignment in the class. Verify all assignments after changes!
Score categories can be weighted with percents to ensure that they have the desired
value. For example, tests could be worth 50%, homework 30% and participation 20%. If
you use weights, be sure that their sum is 100%.
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■

There is one drawback to using category weights that needs to be understood: classes
that use category weighting can only have their terms combined using term weights.
Classes that don’t use category weighting can have their terms combined using term
weights or points. Refer to the section Setting Combine Term Options on page 5-6.

Setting Score
Footnote Options

Score footnotes are short comments that can be attached to scores to provide additional
meaning. These comments can be included in progress reports and filters. Footnotes can be
attached to scores in several ways: 1) by double-clicking on a score cell and then selecting
the footnote from a list; 2) by pressing the footnote number on the keyboard while holding
down the option key (Macintosh) or alt key (Windows); 3) by right-clicking on a score cell
(Windows); and 4) by clicking on a footnote in the mini-summary palette.
■ Score Footnote options can be viewed and edited only in the Class Options window.
■ If you change a footnote that is already being used, be sure to limit the change to
something with the same meaning, or remove the footnote from the scores that use it.

Setting Special Score
Options

Special scores are scores that you design. Some examples include ex, yes, no, + and √. They
can only be used in place of numeric scores on assignments. A special score has five
attributes. Its name is used as a key in reports. Its code is used in place of the numeric
score. Its shortcut is a single key that, when pressed, enters the code into a score cell. The
value% is the percentage value of the score and missing determines whether the score
should be picked up when a missing work filter is used or a missing work report is printed.

■
■
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Special Score options can be edited only in the Class Options window.
You may define up to thirty special scores.

■

■

■
■

It is best if your special scores do not include numbers because of the confusion that may
result. If you do use numbers, include other symbols so it is clear that the score has a
different meaning. For example, consider using +1 through +5 instead of 1 through 5.
As an exception to the rule above, you may want to use 0 as a special score if you would
like to have zeros count as missing when missing work filters are used.
The value of a special score should be blank (no value) or between 0 and 100%.
If you change a special score that is already being used, any location that had the prior
score will display the new one.

Special score codes can be entered into score cells in three ways. A code can be entered by
clicking on the tool bar (see below). A code can be entered by direct typing if the
Gradebook Option Allow typing of Grades and Special Scores is on. A code can also be
entered by pressing a single-key shortcut if the Gradebook Option Allow typing of Special
Score Shortcuts is on. Of the three methods, the shortcut is fastest. To quickly switch
between the direct typing and shortcut modes, use the small menu (circled below) on the
tool bar to the left of the grade click buttons.

You can set up to fifteen attendance categories. An attendance category has four attributes.
The category is the full name of the category. The master category names the major
grouping that the category belongs to. The code is the one- or two-character mark that is
entered in an attendance cell. The value is used when calculating totals and should be 1.00
for full-day marks, 0.50 for half-day, etc.

■
■

■
■

■

Setting Attendance
Category Options

Attendance options can be edited only in the Class Options window (Attend. tab).
You can change items at any time, but it is best not to change items that are being used
unless you simply change a name to a synonym.
You should never remove items in use, or change their position.
Each term of a class should have the same attendance codes. When attendance is
combined across terms, it is matched using the codes.
Elementary teachers can use just one class for attendance each term because the multiclass progress report will automatically find that class when compiling the report.
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Setting Calendar
Options

Calendar Options allow you to set the days that the class meets, the starting and ending
dates and no-school days. A calendar only needs to be set if attendance will be taken.

■
■

Setting Combine Term
Options

Calendar options can be edited only in the Class Options window.
Set your calendar carefully. Once student attendance data has been added to a class, you
will be able to change neither the days that the class meets nor the first day of the term.

In Easy Grade Pro, each term of a class is actually a separate and distinct class within the
gradebook. For example, let’s say an instructor will be teaching Chemistry for two quarters.
To add the class to the gradebook, the instructor opens the Records window, types the
name of the class and adds two check marks in the Terms column. Easy Grade Pro will
actually add two classes to the gradebook: Quarter 1: Chemistry and Quarter 2:
Chemistry.
There are several benefits to having each term as a separate class. Grade scales, categories
and other options can be changed in one term without data in prior terms being
inadvertently changed or regraded. Students can be removed from one term without losing
their data in earlier terms. Switching classes is faster because class data are smaller.
The Combine Term options are used to combine data in one or more prior-term classes
with the current class. When terms are combined, Easy Grade Pro goes to each of the priorterm classes set in the Class Options window and tries to match the students. Whenever a
match is found, the student’s points, grade and attendance data for that term are copied to
and combined with the current class using the combining method that has been set.
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■
■

■

■

■

■

Combine Term options can be edited only in the Class Options window.
Choose Combine grades using weights to ensure that each term has a set value. Don’t
use this method unless you are at or near the end of the current term because temporary
grade distortions can occur when the current term has only a few assignments.
Choose Combine grades using points if you want the current term to be a direct
continuation of the prior term or if you want the sum of the points in a term to determine
the weight of the term. This option is not available if any of the classes being combined
uses score category weighting.
You may choose to match the students by ID or student name. Each student’s ID
number or name must be identical in all terms.
Select the prior-term classes by pressing on the menus below the name of the current
class. When selecting classes, ignore all combining that may have occurred earlier
in the year. Select ALL classes that you want combined even if one of the classes already
has prior-term data combined with it.
Enter the term weights as desired. If you want reports to display individual terms without
combining the term grades, use 100% for the current term and 0% for others.

What do I do when a student doesn’t match?
When terms are combined, a window will always appear listing any students that could not
be matched. If a student didn’t match but should have, it is probably because the student’s
name or ID number is different. You’ll have to change the name or ID in the affected class
and then, from the current-term class, choose Recombine Terms from the Tool menu.
How is a class changed by using combine term options?
After combining, the overall grades and attendance totals found in charts, summaries and
reports reflect all combined terms. In the scores and attendance charts, special columns can
be added adjacent to the column of student names that show data from individual terms.
(See Chapter 8, “The Score Chart”.) Many reports and summaries will display multi-term
data automatically or as an option.
How often do I need to combine terms?
You usually do not need to set term options more than once in a term for a class. Whenever
you enter a score or attendance mark in your current class, Easy Grade Pro calculates new
totals that include the copied, prior-term data. However, if you make changes to grades or
attendance data in any of the prior term classes, you should recombine the terms to
bring the updated data into your current term (see the next section to learn how).
How do I recombine terms?
Recombining terms causes Easy Grade Pro to go back to each class that is combined with
your current class and recopy the grades and attendance data. This is used whenever the
current copied grades or attendance data are not complete or not current. To recombine the
data, choose Recombine Terms from the Tool menu.
How do I un-combine terms?
You may occasionally want to combine terms just long enough to print certain reports. To
later un-combine terms, open the Class Options window to the Term view. Press on each
prior term class listed in this window and choose None in the menu that appears. When you
exit from this window, your class will be un-combined.
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Can I combine a class that has a class combined with it?
There might be some question about which classes to select and what weights to use if a
prior-term class has a class combined with it. For example, let’s say that at the end of
Semester 2 you combined Semesters 1 and 2. Now it is the end of Semester 3 and you
want to combine all three terms. What should you do? Here is the rule to follow: when
setting Combine Term options, ignore all combining that may have occurred earlier in
the year. You should combine Semesters 1, 2 and 3, and if you want them weighted equally,
use 33.3%, 33.3% and 33.4% for the weights.
I have to include a weighted final exam. What do I do?
When a final exam must be weighted with one or more other terms, the final exam should
be treated in the same way as the terms. As an example, you might set up your terms in the
Records window as follows: Semester 1, Semester 2 and Final Exam. Your Final Exam will
actually be a separate class within your gradebook. From within the Final Exam Class, you
might set the combine term options as follows: Semester 1 - 40%, Semester 2 - 40% and
Final Exam - 20%. The overall grades will be found in the Final Exam class.

Setting Seat Format
Options

If you plan to use the seating chart for a class, you can use the Seat Format options to set the
size, shape, name and formats for all the seats.

■
■
■
■

Seat Format options can be edited only in the Class Options window.
To change the seat shape, drag the box at the lower-right corner of the sample seat.
Use the buttons to set the name and attendance formats. These options affect all seats.
If you would like to change the rotation, color or locked status of a seat, double-click on
the seat in the actual seating chart. The format window will appear for that seat.

Setting Color Options

You can set the background and grid colors in the Class Options window. These colors are
used in all charts, in bar graphs on the screen and in printed reports. If your computer is set
to more than 256 colors, you can click the small buttons above the two sets of colors to open
the standard color picker window where additional colors are available. If you choose one of
these colors, it will be displayed in a small box next to the button.

How to copy options to
other classes

It is easy to copy some or all of the options in one class to other classes using the Copy Class
Data window. Choose Copy from the Tool menu or click the Copy Class Data tool and select
the Options tab. In the upper-left list, select the class to copy from. In the lower-left list,
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select the class(es) to copy to. Select the options you wish to copy and click Copy. Use
caution in copying class options: you might accidentally copy options that you don’t want
copied, causing unintentional changes to occur.

Note: This ends the last section on Class Options. The remainder of this chapter explains
Gradebook Options and tools that affect the entire gradebook.
Display Options include font, font size, column and row highlighting, student name order,
and other items that affect the display in the five main charts. These can be edited only in the
Gradebook Options window.

■

■

■

■

■

Copy Class Data Tool

Gradebook Options

Setting Display
Options

The Font and Size menus affect display in the main charts and the text in the Summaries
and Score Notes windows.
The Highlight menu items control how a column and row are highlighted whenever a
cell is selected in one of the charts.
The Show Students menu allows you to set the order of a student’s first and last names
in most charts and reports. (This menu does not affect the seating chart.)
The Show Grades menu allows you to set the display of grades (not scores) in the
charts. It has no effect on student reports (which have their own Show Grades menus).
The Show for missing work option causes an M to be drawn in the score chart for
each student that has at least one score that counts as missing.
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Setting General
Options

General Options control the behavior of typing, warnings, scrolling, the movement of
palettes and compression. These can be edited only in the Gradebook Options window.

■

■

■

■

■

■

■

■

■

Setting Security
Options

Security Options include teacher and TA passwords, backup preferences and TA access
privileges. These can be edited only in the Gradebook Options window.
■

■

■

■
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The Allow typing of Special Score Shortcuts option allows you to use the single-key
special score shortcuts set in the Class Options window.
The Allow typing of Grades and Special Scores option allows you to type grades and
special score codes directly into scores cells in the score chart.
The Give warning when a score is changed option allows you to be given a warning
when a non-blank score is changed. This can help minimize accidental changes.
The Give warning when a score exceeds the maximum option allows you to be given
a warning the first time a score is entered which exceeds the assignment’s maximum.
The Scroll to top when the last score is entered option makes it easier to enter scores
from a paper gradebook without having to do any scrolling. When a score is entered for
the last student, Easy Grade Pro will scroll up to the first student on the next assignment.
The Scroll to left when a cell is selected option causes Easy Grade Pro to scroll the
selected item to the left. (This affects all charts but seating.)
The Palettes: automatically position based on chart option causes the floating tool
palette and the mini-summary window to automatically move up or down, based on the
chart. Palettes move up in the score and attendance charts, and down in the others.
The Palettes: hide in Seating, Student & Assign. charts option causes the floating tool
palette and the mini-summary window to automatically close (disappear) whenever
moving to the seating, student and assignments charts.
Use the Compression option to cause each class to be compressed during automatic
saving. The class will take up less space but will take more time to save. To compress the
entire gradebook, choose Compress from the File menu.

Use the Set Teacher Password button to open a window where the teacher password
can be entered or changed. This password is used to gain full access to a gradebook.
Use the Set TA Password button to open a window where the TA password can be
entered or changed. This password is used to gain limited access to a gradebook.
The Password Protect... options allow you to set whether the gradebook becomes
locked whenever you quit or only if you choose Lock.
The When Close or Quit... options allow you to control the type of backup prompt that

■

appears whenever you quit or close your gradebook.
The Allow TA to... options are used to set access privileges for a TA. The TA mode
allows you to give access to another person while still protecting your gradebook and
student privacy rights. The teacher password is required to turn off the TA mode.

Clipboard text items are stored sentences and paragraphs that can be pasted into score
notes, summary notes and student reports. There is no limit to the number of clipboard text
items and each has a 32,000 keystroke limit. Numerous variables can be added to the text;
Easy Grade Pro completes the variables with student data at the time the text is printed or
pasted into notes. A 50,000-word dictionary is available.
Clipboard text can be created, edited and stored only in the Clipboard Text view of the
Gradebook Options window. This can be opened from the Edit menu and by selecting the
Clipboard tool found in all text windows.

■
■
■
■
■

■

Setting Clipboard Text
Options

Clipboard Tool

To edit a text item, first select it in the left list. The full text will appear to the right.
To create a new text item, select the last list item titled NEW ITEM. Then type the text.
To delete or duplicate an item, press on the small blue arrow above the list of items.
You can use all basic editing commands on the text.
Use the four menus below the text to add text variables. You may need to put a space
before and after each variable to ensure proper spacing when Easy Grade Pro later
substitutes the variable with student data.
Click the Spell button to bring up the Spell Check window (described next).
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Using the Spell Check
Window

Click the Spell tool in the Clipboard Options, Score Note, Summaries or the Report Text
Options window to bring up the Spell Check window. This function will check your text. If it
finds an unknown word, it will display the word with possible replacements. A column of
buttons appears to the right.
■ Click Replace to change the unknown word to the selected word from the dictionary.
■ Click Skip for words that you know are correct but don’t want added to the dictionary.
■ Click Learn for words that you know are correct and do want added to the user dictionary.
■ Press on the blue arrow to turn Smart Typing on and off. Smart Typing allows you to type
a word in an attempt to find the correct spelling. As you type, the spell checker will try to
complete it for you.
■ Click Cancel to stop the checking of words.
■ Note that the numbers of unknown and checked words appear at the bottom.

Setting Report Label
Options

Report Label options allow you to change the titles and labels used in student reports. Easy
Grade Pro has labels in three different languages (English, French and Spanish) and each can
be customized. You can even create labels for a fourth language of your choice. Report labels
can be edited only in the Gradebook Options window which can be opened from the Edit
menu and from the Print Reports window using the Labels button.

■
■
■
■

Setting Tool Options
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Begin by using the Language menu to set the language you wish to customize.
Use the last menu item to add your own language or to add an alternate set of labels.
Use the Records window or the student chart to assign a language to a student.
The built-in label will be used unless you enter your own.

From the Edit menu you can access options for four special tools. These tools include the
tool bar, tabs, tool palette, and mini-summary window. In Chapter 2 you’ll find a Quick
Reference sheet which describes the tool bar and tabs in detail.
■ The tool bar includes a Class Menu, tools and click buttons along the top portion of the
screen. Macintosh: It can only be used on monitors with resolution of at least 640 x 480.
■ The tabs are found above the tool bar and allow you to quickly navigate the five charts.
■ The tool palette is like the tool bar but is a small floating window. It can be used on all
monitors regardless of resolution but cannot be used at the same time as the tool bar.
■ To relocate a tool on the tool bar or palette, press on it and drag to the new location. To
change a tool, press and hold until a menu appears. Then choose the new tool.
■ The Mini-summary is a small floating window which provides summary information as
you work and also allows you to view score notes and add footnotes.

Chapter 6

Students
This chapter explains how to add, copy, sort, edit, withdraw, delete and transfer students.

Whenever a class without students is displayed, a window appears (shown below)
requesting that you choose how students are to be added to the class.

■

■

■

■

A class without
students

You shouldn’t select the Type Student Names button unless it is your only option,
because it is the most time-consuming of all options.
Whenever possible, click the Copy Students from the PRIOR TERM button because the
students will instantly appear without any more effort on your part. And this will ensure
that student names are the same in each class.
The Copy Students from another Class button should be your second choice. If clicked,
the Copy Class Data window will open allowing you to copy students.
If you have access to another Easy Grade Pro gradebook or a TEXT file with the right
students, you can click the Import from another file button.

1 Open the Records window to the first empty student record.
There are four ways to open this window so that it automatically displays the first empty
student record: 1) click the Type Student Names button (shown in the last section); 2)
select Add Student from the Tool menu; 3) click the Add Student button in the score,
attendance or student charts; or 4) click the Add Student button on the tool bar.

How to add students by
typing
Add Student Tool
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Press to open the Auto ID Options window

2 Type the last name and press tab. Type the first name and press tab.
Notice that after both names are typed, the Next Student >> button that leads to the
next record becomes framed. Any framed button can be selected by pressing enter.
After the names have been entered, you can move to the next student by pressing enter.
Be careful because once you have entered the student’s last and first names, if you press
enter intending to move down to the next field in this record, you will actually move
to the next student’s record. If this happens, click the << button.
3 (Optional) Enter the ID by typing or have it set automatically. Press tab.
The small button after the ID number field opens a window where automatic ID
numbers can be set.
4 (Optional) Set the student’s gender.
Gender is used in custom filters and in clipboard text.
5 (Optional) Change the student’s status.
You may choose between Active, WD (grayed) (withdrawn and grayed in the charts)
and WD (hidden) (withdrawn and hidden in the charts).
6 (Optional) Change the student’s grade scale.
Easy Grade Pro will automatically assign the first grade scale to a new student.
7 (Optional) Change the student’s report language.
This option affects the titles and labels used in progress and missing work reports. You
can select English, Spanish, French or a user-specified language. The labels can be edited
in the Gradebook Options window.
8 (Optional) Edit the Custom Labels and add Custom Data.
There are twelve text fields. You can set the labels of these fields as well as enter any
kind of information. You might include phone number, parent name, address (to be used
in mailing labels), reading group, etc. Changes made to these labels will apply to all
classes within a gradebook but the data are unique to each class.
9 Press enter to move to the next student.
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Whenever possible, copy students from one class to another rather than type student
names. It’s faster and ensures that the names and other data are identical.
1 Open the Copy Class Data window.
To do this, click the Copy tool or choose Copy from the Tool menu.

How to copy students
to other classes
Copy Tool

2 Select the Students tab. In the upper-left list, select the class to copy
from. In the lower-left list, select the class(es) to copy to.
3 Select the students you wish to copy and click the Copy button.
After clicking, the students will be copied to the selected classes.
At any time, you can view, edit or add data to a student record. You may wish to modify the
name, change the student status or make some other changes.
To make changes, choose Records from the Chart menu or click the Records tool. Click the
Students tab and make the desired changes.
Easy Grade Pro gives you complete control over the order of students in a class. There are
three general ways to change student order: sorting, dragging and editing.
Sorting Students
You can sort your students by last name, first name and several other ways using the items in
the View menu. You can also sort students using the Sort tool on the tool bar. This tool sorts
student by name in the scores, attendance and students charts. In the seating chart, it sorts
students randomly.

How to make changes
to a student record
Records Tool

How to change
student order

Sort Tool

Dragging to Change Student Order
In most charts you can change student location simply by pressing on the student’s name
and dragging. The example below illustrates this in the score chart.
1 Press on the student's name.
A frame will appear around the row.
2 Drag up or down to the desired location. Release the button.
As you drag, the frame will move from row to row. After releasing, the row will be
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automatically cut from the prior location and pasted into the new location.

Editing to Change Student Order
Basic editing can be used to move one or a group of students simultaneously.
1 Click the row number of the student to be moved.
After clicking, the student's row will be highlighted. You can select more than one row if
you press on the row number and then drag up or down.

2 Select Cut from the Edit menu.
The row(s) will be removed and placed on the computer's clipboard.
3 Select the row where you would like the student(s) to be by clicking on a
single row number.
You may select any currently used row or the row immediately following the last student
in the current class, in another class, or even in another gradebook.
4 Select Paste from the Edit menu.
The row(s) will be pasted into the list. All students already in the list from the selected
row on down will be moved to make room for the pasted student(s).

How to withdraw a
student

Easy Grade Pro allows you to withdraw a student without removing the student from the
class. When a student is withdrawn, you can elect to have the student hidden from the charts
or just grayed. If a student is grayed in the scores or attendance charts, cells cannot be
selected and data cannot be changed. The letters WD are appended to the name of a
withdrawn student. When printing reports, withdrawn students will be skipped unless
specifically chosen.
1 Open the student record for the withdrawing student.
The easiest way to do this is to double-click on the student's name in any of the charts
(except the seating chart).
2 Use the status menu to select either WD (grayed) or WD (hidden).
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Use this menu to withdraw a student

3 Click Done to exit.
If you selected WD (hidden), the student will be removed from all charts. If you selected
WD (grayed), the student will be removed from the seating chart but will be grayed in
the other charts as shown below.

There are two ways to delete students: using editing and using the Delete window.

How to delete a
student

Deleting a Student by Editing
1 In a chart, select the student by clicking on the student’s row number.
If you wish to delete a series of students, press on the first row number and then drag
down to the last student.
2 Delete the selected student(s) using one of the following: 1) the Delete
tool, 2) the delete key, or 3) Clear in the Edit menu.
You may need to repeat these steps in other classes.

Delete Tool

Deleting a Student using the Delete Window
1 Choose Delete Student from the Tool menu.
This will open the Delete Records window, where any records can be deleted.

2 Select the student or students to be deleted from the list. Click Delete.
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How to transfer a
student

How you transfer a student depends on whether the assignments and calendars in the
original class and the transfer class match exactly.
Transferring a Student when Classes Match
If the two classes match exactly (assignment order, assignment settings, calendar settings,
score footnotes, etc.), it is easy to transfer a student using basic copy and paste. Simply
select the student’s row number in the score or student chart and choose Copy from the
Edit menu. Then switch classes, select any row number and choose Paste from the Edit
menu. This method is preferred because it not only transfers the student’s name, scores
and attendance data, but score notes, footnotes and summary notes as well.
Transferring a Student when Classes Do Not Match
Transferring a student is more difficult when the classes don’t match. In this case, you may
want to simply print out scores and attendance charts and retype the data into the proper
columns. If the transfer class has different assignments or different settings, it may not be
possible to retype all scores and maintain the student’s transfer average.
In this case, you may want to simply add a new assignment column used solely to give the
student a transfer grade. Here are some suggestions when doing this:
■
■
■

■

■
■

■
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Use an assignment name like Tommy’s Transfer Grade.
Set the assignment’s maximum score to 100 since you will be transferring a percent.
Set the assignment’s points value to the sum of all the points currently in the class. This
will ensure that the student’s transfer grade has the same weight as all the assignments
currently in the class. The Summaries window (Class or Student Grades views) can help
determine the number of points possible from all assignments.
Set the assignment’s progress report option to Include if student has score. This
ensures that the assignment will not appear on another student’s progress report.
In the score cell for this student, enter the student’s transfer percent.
If you use category weighting in the class, you may need to follow these steps for each of
the categories instead of for the class as a whole.
If you use category weighting and you want to transfer a student to a class in a term that
has already ended, you may simply type the student’s name in the transfer class and use
the Lock Grade to enter and lock in the transfer percent. Refer to the section Locking
Grades on page 8-8 for help. Note: this method should not be used in a class without
category weighting if the class will be combined with other terms using points because it
does not give the student meaningful points earned or points possible values.

Chapter 7

Assignments
In this chapter, you will learn how to add, copy, edit, sort, and delete assignments. At the end
you’ll find an explanation of how Easy Grade Pro calculates overall percents.

Assignments can be added to a class by typing, by copying from another class or by importing
from a class in another gradebook. This section explains how to add assignments by typing.
1 Open the Records window to the first empty assignment record.
There are three ways to open this window so that it displays the first empty record: 1)
select Add Assignment from the Tool menu, 2) click the Add Assignment button in the
score or assignment charts or 3) click the Add Assignment tool on the tool bar.

How to add
assignments

Add Assignment Tool

2 Type the assignment Name and press tab.
After typing the name, the Next Assignment >> button that leads to the next
assignment record becomes framed. Any framed button can be selected by pressing
enter. After the name has been entered, you can move on to the next assignment at any
time by pressing enter. But be careful because once you have entered the name, if you
press enter intending to move to the next field in this record, you will actually move
to the next record. If this happens, click the << button.
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3 Type the assignment’s Maximum Score and press tab.
Maximum score refers to the score that earns 100%. The maximum score is used only to
determine the student’s percent on the assignment. Here’s the formula: percent =
(student score / maximum score) x 100. If a student’s score is 15 and the maximum
score is 20, Easy Grade Pro calculates (15/20) x 100 and gets 75%. Note that maximum
score has nothing to do with the assignment’s weight. Also note that if the assignment is
being used for extra credit or is a non-graded item, maximum score is ignored.
4 Type the assignment’s Points and press tab.
The points, or points possible value, refers to the true value of the assignment. The
higher the number, the greater the value of the assignment. It is used by Easy Grade Pro
to determine the points earned out of the points possible. Here’s the formula: points
earned = (student percent/100) x points possible. Using the example above in which
the student earned a 75%, the student will earn 15 points if there are 20 points possible,
75 points if there are 100 points possible and 150 if there are 200 points possible. In its
simplest form, a student’s overall grade is based on the sum of the points earned on all
assignments divided by the sum of the points possible.
What’s your Grading Style?
For some teachers, the scores put on papers are not be the number of correct problems but the number of points earned. In
this case, scores and points earned are the same thing. If you grade this way, when you add an assignment to your gradebook,
you should set the maximum score and points to the same value. If, on the other hand, the scores you put on papers do not
directly relate to the value of the assignments, when you add an assignment, you will probably set the maximum score and
points to different values. You may want to use a points value of 100 for typical assignments, 50 for assignments that have half
the typical value, 200 for assignments that are double, and so on.

5 Select the assignment's due date.
The calendar is initially set to the current date. If the date showing is not the current date,
then the computer's clock may be improperly set or its battery may be dead. Your
computer's manual can provide help with this. You can click on the dates, the month
arrows and even the year to change the date.
6 Select the assignment's category.
The category is used in summaries, reports and in grading if categories are weighted.
7 Select the Special Status option.
Special status options include the following items:
■ Normal. No special action is taken.
■ Extra credit. Any score entered for a student will increase the number of points the
student has earned without increasing the number of points possible. In other words,
the student’s average will go up. Students without scores are unaffected.
■ Can be dropped. Easy Grade Pro will drop this assignment for a student if, by
dropping it, the student's overall percent is improved more than by dropping any
other assignment that can be dropped. On the score chart, a small letter d is always
drawn next to a dropped score.
■ Not for grade. The assignment will not be included when determining grades. It can
be used for recording items such as whether a progress report has been
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■

returned. It can also be used to temporarily turn off a group of assignments so that
they do not influence the overall grades. This is best done from the assignment chart.
(-)Negative Points. Any score entered for a student will decrease the number of
points the student has earned without decreasing the number of points possible,
causing the student’s average to go down. Students without scores are unaffected.

8 Select the Display Scores option.
Use this to specify whether the scores will appear as raw scores, percents or grades in
the score chart. There is a small menu in the score chart that can override this setting,
and force all assignments to be displayed as raw scores, percents or grades.
9 Select the Progress Report option.
Progress report options include the following items:
■
Include Assignment. The assignment will be included on every student’s progress
report whether the student has a score or not.
■
Include if Student has Score. The assignment will be included only if the student has
a score. This option allows you to add columns to your score chart that only apply to
one or some students. If you use this for all assignments, a transfer student’s
progress report will not show assignments prior to the transfer.
■
Exclude Assignment. The assignment will not be included in any progress report.
10(Optional) Enter text in the Note field.
Text could include the assignment objective or purpose. It can also be used in
conjunction with custom filters to allow you to show or hide the assignment based on
any criteria that you choose.
11Select Next Assignment >> to move to the next assignment, if any. Then
select Done.
Whenever possible, it is better to copy assignments from one class to another because it’s
faster and ensures that the assignments are identical.
1 Open the Copy Class Data window.
To do this, click the Copy tool or choose Copy from the Tool menu.

How to copy
assignments to other
classes
Copy Tool
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2 Select the Assignments tab. In the upper-left list, select the class to copy
from. In the lower-left list, select the class(es) to copy to.
3 Select the assignments you wish to copy and click the Copy button.
After clicking, the assignments will be copied to the selected classes.

How to make changes
to an assignment
record
Records Tool

How to change
assignment order

Sort Tool

At any time, you can view, edit or add data to an assignment record. You may wish to modify
the name, change the points or make some other changes.
To make changes, choose Records from the Chart menu or click the Records tool. Click the
Assignments tab and make the desired changes.
Easy Grade Pro gives you complete control over the order of assignments in a class. There
are three general ways to change order: sorting, dragging and editing.
Sorting Assignments
You can sort your assignments by date, category, and name using the items in the View
menu. In the assignment chart, you can also sort assignments by date using the Sort tool on
the tool bar.
Dragging to Change Assignment Order
In the score and assignment charts you can change assignment location simply by pressing
on the assignment’s name and dragging. The example below illustrates this in the
assignment chart.
1 Press on the assignment’s name.
A frame will appear around the row.
2 Drag up or down to the desired location. Release the button.
As you drag, the frame will move from row to row. After releasing, the row will be
automatically cut from the prior location and pasted into the new location.

Editing to Change Assignment Order
Basic editing can be used to move one or a group of assignments simultaneously. This
works in both the score and assignment charts but is illustrated below using the assignment
chart.
1 Click the row number of the assignment to be moved.
After clicking, the assignment’s row will be highlighted. You can select more than one
row if you press on the row number and then drag up or down.
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2 Select Cut from the Edit menu.
The row(s) will be removed and placed on the computer's clipboard.
3 Select the row where you would like the assignment(s) to be by clicking
on a single row number.
You may select any currently used row or the row immediately following the last
assignment in the current class, in another class or even in another gradebook.
4 Select Paste from the Edit menu.
The row(s) will be pasted into the list. All assignments from the selected row on down
will be moved to make room for the pasted assignment(s).
There are two ways to delete assignments: editing and using the Delete window.

How to delete an
assignment

Deleting a Assignment by Editing
1 Select the assignment by clicking on the assignment’s column number
(score chart) or row number (assignment chart).
The assignment will become highlighted. If you wish to delete a series of assignments,
press on the first number and then drag to the last.
2 Delete the selected assignment(s) using one of the following: 1) the
Delete tool, 2) the delete key, or 3) Clear in the Edit menu.

Delete Tool

Deleting a Assignment using the Delete Window
1 Choose Delete Assignment from the Tool menu.
This will open the Delete Records window, where any records can be deleted.
2 Select the assignment(s) to be deleted from the list. Click Delete.
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How is a student’s
overall percent
calculated?

At times you may wish to confirm Easy Grade Pro’s calculations. Possibly, this will be at a
student’s or parent’s request. The information here explains with examples how overall
percents are calculated. We’ll use the same five assignments in all examples as shown.
Assignment Data
Name

Quiz 1
Quiz 2
Hwk 1
Hwk 2
extra credit hwk

Max. Score

10
15
8
12
---

Student Data
Points Possible Score
%

100
100
50
50
---

6.5
12
8
9
2

65%
80%
100%
75%
---

Points Earned

65
80
50
37.5
2

Note that the Max. Score and Points Possible are taken from the assignments’ records; the
% is found by dividing the score by the maximum score; and the Points Earned is found by
multiplying the percent by the points possible. By the way, you can print a progress report
for a student with all these values and more. (In the Report Options window for the
progress report, be sure to turn on the Points Earned options for the Grade Summary and
Assignment Charts.)
Example 1: A Simple Situation
If category weighting is not used, Easy Grade Pro tabulates the number of points the
student has earned and divides this by the sum of the points possible on the graded
assignments. If there are extra credit or negative points, then these are added to the points
earned value before dividing. Here’s how:
1. Sum the points earned: 65 + 80 + 50 + 37.5 + 2 = 234.5
2. Sum the points possible: 100 + 100 + 50 + 50 = 300
3. Divide points earned by points possible: 234.5 / 300 = 78.17%
Example 2: Category Weighting
If category weighting is used, Easy Grade Pro goes through the calculations in Example 1 for
each category. Then it weights the categories and combines them to produce the overall
percent. In this example, the quiz category is weighted 60% and homework is weighted
40%.
1. Determine the quiz category percent: (65+80) / (100+100) = 72.5%
2. Determine the homework category percent: (50+37.5+2) / (50+50) = 89.5%
3. Weight the categories: ((72.5% x 60%) + (89.5% x 40%)) / (60%+40%) = 79.3%
Example 3: Combining Term Grades
What if one or more prior-term classes have been combined with the current class? What
happens depends on whether the classes have been combined using points or weights.
If the terms have been combined using points, then it is a simple matter to sum all the
points. For example, if the student above earned 234.5 out of 300 points this term and 222
out of 250 points last term, the student will have earned 456.5 out of 550 points or 83%.
If the terms have been combined using weights and each term is worth 50% of the grade
and the student earned a 79.3% this term and an 88.8% last term, then the student will have
earned ((79.3% x 50%) + (88.8% x 50% )) / (50% + 50%) or 84.05%.
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Chapter 8

The Score Chart
The score chart is where you’ll likely spend most of your time while using Easy Grade Pro. The
posting of student scores can be tedious and time-consuming, but Easy Grade Pro provides
numerous tools to make this task fast. This chapter describes a variety of ways to enter scores,
to add notes and to manipulate data using the score chart.

You can enter scores by typing, clicking, filling, editing and using the Change Score tool.
When entering scores by typing, follow these guidelines:
■
You can enter numbers from zero through 999.9.
■
After typing a score, press return, enter or the down arrow key to move to the next cell.
■
To move in another direction, use the tab, up, left and right arrow keys.
■
Macintosh: To jump to any student, press control and the first letter of the student’s
name as it appears in the chart. Press them again to jump to the next occurrence.
■
Windows: Right-click on any student or assignment name to display a contextual menu.
■
To repeat a score (copy the score from the cell above), press the = key.
■
To delete a score, press the delete key. To delete a group of scores, first select the cells
by dragging from the first to the last, then press the delete key.
■
You can type the single-key shortcuts for special scores if the Allow typing of Special
Score Shortcuts option is selected in the Gradebook Options window.
■
You can directly type grades and special scores if the Allow typing of Grades and
Special Scores option is selected in the Gradebook Options window.
■
You can switch between these two typing modes using the small menu to the left of the
row of grades on the tool bar (shown below).

■

How to enter scores by
typing

If you type a score that is greater than the maximum score or if you change a non-blank
score, a warning may appear if the warning options are turned on in the Gradebook
Options window. These warnings can help minimize mistyping.
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Blank Score Cells
In Easy Grade Pro, a blank score has no value and is completely ignored when calculations are made. This allows you to add
assignments in advance without affecting grades. It also allows you to add assignments that are not meant for all students. An
assignment can be excluded from progress reports when scores are blank using an option in the record window for the
assignment. Blank scores can be included in filters such as the Show Blanks filter which hides all scores but blank ones. Don’t
think that you’ll have to spend a lot of time filling in all the blanks with zeros; the Change Scores tool can easily change all
blanks (or just some blanks) to zeros (or something else) with just a few clicks.

How to enter scores
by clicking

You can enter scores by clicking on grade and special score buttons on the tool bar or
palette. Follow these guidelines:
■

■

■

■

■

■

How to enter scores
by filling down/across
Fill Down Tool

Fill Across Tool
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The tool bar or palette must be visible. If not, choose Show Tool Bar or Show Tool
Palette from the Edit menu. Note that you cannot have the tool bar and tool palette
visible simultaneously.
If the grade buttons are not visible on the tool bar, click the triangle (shown below) to
the left of the class menu. (This triangle is not found on the tool palette because the
grades buttons are always visible there.)

To display grades, special scores or both, use the menu to the left of the first grade or
score.
The grades that are displayed are always based on the scale assigned to the student
whose score cell is selected.
When a grade is clicked, Easy Grade Pro will enter a raw score in the score cell based on
the click value of the grade. The click value is set automatically to 100% for the top grade
and to the middle of the grade’s range for the rest. You can edit the click values for any
grade scale in the Scale view of the Class Options window.
After clicking, Easy Grade Pro will automatically scroll down to the next student.

To fill down means to copy a score from a starting cell downwards to the last row. It is
typically used when most of the scores on an assignment are the same. If there are a few
scores that are different, they can be changed after filling down. Begin by selecting the
starting cell. Type the score but do not press enter or else the score will no longer be
selected. Finally, select the Fill Down tool or choose Fill Down from the Tool menu.
To fill across means to copy a grade from a starting cell across to the last column. It is
normally used on a transferring student to apply the transfer grade to all assignments given
prior to the transfer. Note that the grade, not the score, is filled across. Each assignment may
have a different score but each will have the same grade value. Begin by selecting the
starting cell. Type the score but do not press enter or else the score will no longer be
selected. Finally, select the Fill Across tool or choose Fill Across from the Tool menu. An
assignment whose special status is Not for grade is ignored during filling across.

By using the Find tool’s continuous search mode, it is easy to enter scores directly from
student papers -- even if the papers consist of an unsorted mixture of assignments, classes
and students. Here’s how:

How to enter scores
directly from student
papers

1 Open the Find window.
There are two ways: 1) click the Find tool, or 2) choose Find from the Tool menu.
Find Tool

2 Choose by Name from the menu and select Use Continuous Search Mode.
By selecting continuous search mode, you are instructing Easy Grade Pro that you want
to return to this window after every score is entered.
3 (Optional) If the stack of papers includes several classes, you may want to
select Search all current-term classes.
If this is selected, Easy Grade Pro will search other classes if the student cannot be found
in the current class. If you have the same student in multiple classes, you may wish to
search using some other search field that you’ve set up for this purpose.
4 Click Exit or press enter to exit this window.
The window will close. You are now ready to begin entering scores.
5 Select the score cell for the first paper. Enter the score.
After you enter the grade, the Find window will reopen.
6 Enter a few letters of the name from the next paper.
After typing a few letters of the last name (or first name if the students are displayed
with the first name before the last), Easy Grade Pro will attempt to complete the
student’s name for you.
7 Click Find or press enter.
Easy Grade Pro will find the student and select the score cell in the same column as
before. If the wrong student is selected, click the Find Again tool, choose Find Again
from the Tool menu or simply press enter twice. Easy Grade Pro will jump to the next
matching student. If the selected cell is in the wrong assignment column, use the left or
right arrow key to move to the correct column. Repeat this process until all scores have
been entered.

Find Again Tool

8 When you are done, deselect Continuous Search Mode and click Exit.
The window will close and remain closed.
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How to edit scores

Easy Grade Pro allows you to use basic editing (cut, copy, and paste) on one or more scores.
This allows you to copy scores from another program, such as a spreadsheet, into your
gradebook. This also allows you to easily move a group of scores from one location in the
chart to another. Maybe you entered some scores only to realize later that you were off by
one student or assignment. This section explains how to move a group of mistyped scores.
1 Select the group of scores by pressing on the first score and dragging to
the last one.
2 Choose Cut from the Edit menu.
The scores will be removed and placed on the computer's clipboard.
3 Select the new score cell where pasting will begin and choose Paste from
the Edit menu.

The Change Scores
Tool

Change Score Tool

The Change Scores tool allows you to change all occurrences of a score to another score. It
can be used to change all blank scores to zeros, or to change a score that counts as missing
to something else. It can also be used to change all automatically dropped scores to manually
dropped scores (dr) allowing you to drop more than one score per student. You can choose
to change scores on all assignments, displayed assignments or just selected ones.
1 Open the Change Scores window.
To open this window, either select the Change Score tool or choose Change Scores
from the Tool menu.

2 Use the first menu to select the score to change.
If you select Text Score--> from the menu, be sure to type a numeric score.
3 Use the second menu to select the new score.
As before, if you select the last item in the menu, be sure to type a numeric score.
4 Select the range of assignments to be included.
If you choose All displayed assignments, any assignments hidden by filters will not be
affected. Choose Selected assignments ONLY if you selected at least one assignment
column before opening the window.
5 (Optional) If you want scores on ungraded assignments to be included,
select the Include “Not for Grade” item.
The “Not for Grade” attribute is set in the record window for an assignment.
6 Click the Change button.
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A footnote can be attached to a score to provide additional meaning about the score. Perhaps
the assignment was turned in early or late. You can attach one of seven custom footnotes to
a score. When a score has an attached footnote, a small number appears in the lower-left
corner of the score cell (shown right). The actual text of a footnote can appear with the
score in a student progress report. To define or edit a footnote, use the Class Options
window.

How to add footnotes
to scores

There are several ways to attach or remove a footnote:
1 Double-click the score to open the Score Note window and select a footnote from a list.
Select the first list item to delete a footnote.
2 Select the score and press option (Macintosh) or alt (Windows) and a number from 1
through 7. Press option-0 or alt-0 to delete a footnote.
3 Select the score and click on a footnote in the Mini-summary palette. If the palette is not
visible, choose Show Mini-sum. from the Edit menu. Use the menu on the palette to
display the list of footnotes. Select the first list item to delete a footnote.
4 Windows: Right click in a score cell and select the footnote from a contextual menu.
In addition to score footnotes, you may attach a unique textual note to any score. The note
can provide some history or clarification about a score or the note can be used in place of a
score. Perhaps the student could not be scored due to a language problem, or perhaps you
wish to assess and record student performance in a different way. The note can be for your
eyes only or can be included in student progress reports next to the score. A note can be a
few words, sentences and even pages in length. A note can be stored, reused and can even
include variables that are filled in automatically when the note is pasted into the window. A
50,000-word dictionary is available to help ensure the note is error-free.
To open the score note window, double-click on a student’s score cell, click the Open Score
Note tool or choose Open Score Note from the Tool menu.

How to add text notes
to scores

Open Score Note Tool

Use the menus at the top to choose the student, the assignment and the note format. If you
choose the first format Note is for teacher; footnote is for student, you also may attach a
footnote to the score which can be included in a student progress report. The second format
Note is for student and the third format Note is for student in place of score don’t allow
footnotes because a score in a progress report cannot have two notes attached.
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Score Cell

Score Cell

There is a sample score cell in the upper-left corner of the window which shows how the
score cell changes based on what you do. If you add a note using the first or second formats,
a small, black box appears in the upper-right corner of the cell. A footnote number may
appear in the lower-left corner when using the first format. However, if you choose the third
format, a picture of a notebook covers the score cell indicating that a score is not allowed.
The small icon of a clipboard in the window is a menu that allows you to store the selected
part of your note to the Clipboard Text window, paste a stored note or open the Clipboard
Text window (really the Gradebook Options window) where you can create or edit a note to
be used later. Refer to the section Setting Clipboard Text Options on page 5-11 for help.
By clicking the Spell tool, the Spell Check window will open. For help in using this window,
refer to the section Using the Spell Check Window on page 5-12.

How to curve an
assignment

Occasionally, a set of scores on an assignment may have a distribution that is not what is
desired. For example, maybe the assignment was too difficult causing the majority of
students to do very poorly. Whatever the case may be, Easy Grade Pro allows you to curve or
alter the distribution of scores to match your goals.
How to Curve: An Example
Because curving can be complex, this section explains how to curve using an example. In
this example, a group of twenty students was involved in a computerized treasure hunt.
Although the maximum score possible was 950, the students earned scores ranging from
50 to 925. Using the teacher’s normal grade scale, fourteen students failed, five earned
D’s and one earned an A+. This activity requires curving! Here’s how:

Curve Tool

1 Open the curve window for the assignment.
To open this window, first select the assignment. Then click the Curve tool or choose
Curve Assign. from the Tool menu.

This window provides a row of statistics at the top. Below this is a row of menus that are
used to prepare for the curving. In the middle is a graph where the actual redistribution
of grades occurs. The Shift buttons at the bottom can help with this task. When ready,
the Curve button is clicked to initiate the actual curving on the score chart.
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2 From the Curve menu, choose Create New Curve.
A window will open where grades can be listed and given values. Each value is not a
minimum or cutoff percent like in a grade scale; rather, each is the percent of the
assignment’s maximum score that a student will receive for any given grade. To keep
things simple, the teacher decided to create a scale with only five grades. A student
who ends up with an A will get 100% of the maximum score, a B will earn 85% and
so on. Be sure to give the curve a name. Then click the Create button. Note: if you
already created a curve for another class or assignment, you can select it instead.
3 From the Interval menu, choose the desired interval for the graph.
The interval affects curving because all the scores in an interval are curved as a group. In
general, you should use an interval value in proportion to the range of students. Because
the range of students is so great in this example, the teacher chose an interval value
of 10. Notice that the graph interval marks are all multiples of 10.
4 From the Size menu, choose the desired screen width for each interval.
The size does not affect curving -- only the readability of the graph. The teacher chose
the smallest size to minimize the length of the graph.
5 Change the distribution of grades by dragging the vertical lines left and
right to the desired locations and by clicking the two Shift buttons.
This is the step in which you control which students get which grades. The teacher
moved all the lines towards the left so that most students earned A’s, B’s and C’s.
There are special tools hidden in the graph as follows:
■
To show the true percent or the curved percent of any grade bar, press on the grade
label at the top of the bar. A menu will appear with options.
■
To see the names of students and their curved percents, click on any box in the graph.
6 When ready, click the Curve button.
After clicking, Easy Grade Pro will give each student a score based on the percents in the
curve scale. A new assignment column will be added to the score chart immediately after
the curved assignment. The original column will still be present but will be set to nongrade status and exclusion from progress reports. If desired, it can be deleted but may be
kept as a record of the original scores or used to re-curve the assignment again.
Scores in the score chart can be displayed as raw scores, percents and grades. Although an
assignment’s display is set in its record window, you can override this setting so that all are
displayed as raw scores, percents or grades. Use the small menu on the score chart found
next to the intersection of the first student row and the first assignment column.

Displaying scores

Press here
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How to override and
lock a grade

There may be times in which you want to override automatic grade calculations and change a
student’s overall grade. To do this, click on the small square after the student’s grade on the
score chart or choose Lock Grade from the Tool menu. The Lock Grade window will open.

To change a student’s grade, type the new grade in the Locked% column. To change the
grade scale, press in the Grade and Scale column. To unlock a grade, select the locked
grade and press the delete key. After the window is closed, a small padlock will be drawn
next to the displayed grade for any grade that has been locked (shown below).

How to add extra
credit

Extra credit can be added in two different ways: by increasing a score on a normal
assignment or by adding an extra credit assignment.
Giving Extra Credit by Increasing a Score
With this method, simply add the desired number of points to the student’s score. Typically,
this will cause the student to receive a score that is greater than the maximum score for the
assignment. When this happens, Easy Grade Pro may display a window asking if this is a
mistake. Click the Correct Score button and continue. The warning will not reappear unless
you leave and then return to this column.
Giving Extra Credit by Adding an Assignment
An assignment can be dedicated to providing extra credit if the special status attribute is set
to Extra Credit in the record window for the assignment. To check the status of an existing
assignment, double-click on the assignment’s name. For help, refer to the section How to
add assignments by typing on page 7-1.
Sometimes it can be difficult to know what score to enter for a student. It may be very
helpful to open the student’s summary window (double-click on the student’s row number)
and view the list of student grades. This displays the number of points possible and points
earned by the student overall, in each category and on individual assignments. If you know
what impact you would like the extra credit to have, the values in this window can help
determine the score that should be typed.
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Scores can be dropped in two different ways: manually and automatically.

How to drop scores

Dropping Scores Manually
To drop a score manually, simply enter the special score dr into a score cell. This built-in
special score stands for drop and has no value.
Dropping Scores Automatically
To have Easy Grade Pro drop scores automatically, you must choose the Can be Dropped
special status attribute in the record window for one or more assignments.
Whenever any score is entered or changed in a class with assignments that can be dropped,
Easy Grade Pro goes through a series of calculations to determine which score, if any, to drop
for the student. It only looks at scores on assignments with the Can be Dropped status.
Which score is dropped? Surprisingly, it is often not the lowest score because the lowest
score may be on an assignment with little point value or in a category with little weight.
The score that is dropped is the one that, by being dropped, causes the student’s average to
increase the most. When a score is dropped, a small letter d is drawn in the upper-left corner
of the score cell. As scores are entered, the d may move about, disappear and reappear.
Because Easy Grade Pro drops scores in real time (as scores are entered), it can only drop
one score automatically per student. However, it is possible to have more than one score
automatically dropped if you use the Change Scores tool. Here’s how:
1 Set the Special Status option to Can be Dropped on two or more
assignments.
You can set this option in the record window for an assignment. Double-click on the
assignment’s name to open this window. You can set this option for several assignments
using the assignment chart.
2 Open the Change Scores window.
To open this window, either select the Change Score tool or choose Change Scores
from the Tool menu.

Change Score Tool

3 Set the first menu to Dropped Score and the second menu to dr.
This will cause Easy Grade Pro to change all automatically dropped scores to manually
dropped scores on the assignments that you have chosen.
4 Click Change.
The small letter d is replaced by dr, and a new automatic drop calculation is made.
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How to add special
data columns

The first set of columns in the score chart can be customized to suit your needs. Up to eight
columns can be set to student name, grade, class rank, points, term grades, attendance and a
variety of other things. In addition, the columns can be resized and arranged in any order.
Follow these guidelines:
■

■

■
■

■

The titles of the columns are actually menus that pop up and show lists of all the items
that the column can display.
To add a column, press on a column title and choose Add NEW Column. Then press on
the new column’s title and choose the desired content. Shortcut: select a menu item
while pressing the option (Macintosh) or control (Windows) key to get a new column of
the selected type.
To delete a column, press on the column title and choose Delete THIS Column.
To move a column to a new location, press on any data beneath the column’s title. The
cursor will change to a hand. Drag left or right. Note: this does not work with the column
that contains student names because this location is used to drag a student’s row up or
down. To move the student name column, drag the other columns around it.
To resize a column, press on the vertical line after the title and drag left or right.
To relocate a column, press
on the data and drag

How to resize
assignment titles

To resize a column, press on
the line after the title and drag.

The height of the rotated assignment titles can be customized. If your assignments’ titles
are long, you can give them more room in the score chart. If the titles are consistently short,
you can take away some space so that more student rows can be shown on your screen. To
resize the column height, press and drag the thick, horizontal line below the assignment
titles.

Press here and drag up or down

How to filter students,
assignments and
scores
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Easy Grade Pro provides extensive tools for filtering the display of students, assignments
and scores. Filters allow you to show and hide items so that your chart shows just what you
want to see. Several reports allow you to include all data or just the data displayed in a chart.
The rest of this section explains the different types of filters.

The Show Selected and Hide Selected Filters
After selecting one or more students or assignments (by clicking on row and column
numbers), choose Show Selected or Hide Selected from the View menu to display just the
desired items. This can be used to hide all assignments but the current ones or to show just
failing students after sorting by grade. You may need to use Hide Selected more than once
to show just the items you want. Choose Show All to “unhide” all items (except for students
whose status is WD Hidden).
The Show One Filters
Above the first row number in the score chart is a small menu called the Show One Student
menu that allows you to select and display a single student only. All other students become
hidden. To the left of the first column number is a second menu called the Show One
Assignment menu that allows you to select and show one assignment only. Both menus
(shown below) cause Easy Grade Pro to switch to the show one mode in which the function
of the scroll bars changes. The scroll bars scroll the students or assignments one at a time
drawing each in the first position.
One of the best times to use the show one mode is during conferences when the privacy
rights of students must be protected. The Find tool works in the show one mode allowing
you to find any student or assignment and still never have more than one item visible.
Custom Filters menu

Show One Student menu

Show One Assignment menu

The Show One Assignment menu also has category filters which allow you display only
assignments in a single category. This is great when assessing student performance in
individual assignment categories.
The Custom Filters
To the right of the last visible column number is the custom filters menu (shown above). It
holds filters that can show and hide students, assignments and scores simultaneously. For
example, the Show Missing filter displays only students with missing work, assignments with
missing scores and the missing scores. Custom filters can also be selected using the View
menu. Note: to select a filter using the keyboard, you must press shift-command-filter key
(Macintosh) or shift-control-filter key (Windows). All of the filters in this menu can be
edited, deleted and reordered. The next section explains how to create custom filters.
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How to create a
custom filter

Filters Tool

You can create filters to show just the students, assignments and scores you want to see.
Filters can be used in all charts but the seating chart. Before creating your own filter, you
should study the built-in filters to see how they were set up. Choose Edit filters from the
View menu. In the window that appears, select a filter and click the Edit button.
To create your own filter, first open the Filters window using the Filters tool or by choosing
Edit Filters from the View menu. (To change the order of filters, press and drag names.)

Click the New Filter button to open the New Filter window (shown below).

Follow these guidelines when creating a filter:
■ Put a short but clear name in the Filter Name field at the top. It will be placed in the View
and Custom Filters menus and can be selected in all charts but the seating chart.
■ (Optional) Use the Keyboard menu to select a unique key to be used with shift and
command (Macintosh) or control (Windows) to activate your filter.
■ Your filter may contain individual filters for students, assignments and scores. Use the
tabs to switch between these three filters.
■ Each filter consists of from one to four rules. The rules can be connected using and and
or found in the small menus to the left of all rules but the first. And connects two rules
so that they must both be met while or allows either rule to be sufficient.
■ Each rule consists of a subject and a condition that are selected using menus. Depending
on the type of condition, the rule may or may not have an object that must be completed
by typing letters or words into a text field. Case is not important.
■ Be sure to test your filter; you may find that it needs refinement to work properly.
■ Note: filters have no effect on students whose status is WD (hidden).

8-12 THE SCORE CHART

Chapter 9

The Other Charts
Although the score chart is the most comprehensive of the five charts, the attendance, seating,
student and assignment charts share many of its tools and offer a variety of new ones. This
chapter describes the other charts. Be sure to refer to the Quick Reference sheets in Chapter 2
for detailed, concise information on all the charts.

Many of the tools and techniques found in the score chart can also be used in the other
charts. Some of these are...
■
After typing a score, press return, enter, or the down arrow to move to the next cell.
■
To move in other directions, use the tab, up, left and right arrows.
■
Macintosh: To quickly jump to any student (or assignment), press control and the first
letter of the item’s name as it appears in the chart. Press the keys again to jump to the
next occurrence and so on.
■
Windows: Right-click on a student or assignment name to display a contextual menu.
■
To repeat an item (copy the data from the cell above), press the = key.
■
To delete an item, press the delete key. To delete a group of items, first select the cells
by dragging from the first to the last, then press the delete key.
■
Fill down can be used in all charts but the seating chart. Fill across can be used in the
score and attendance charts.
■
The Find tool can be used to find students and assignments in any view.
■
Editing (cut, copy, paste, clear) can be used in all charts.
■
The order of items (students, assignments, seats, furniture) can be changed by sorting,
dragging and editing in all the charts.
■
Custom filters can be used in all the charts but the seating chart. The one-student and
one-assignment views can be found in all appropriate charts.

Tools common to all
charts

The attendance chart allows you to view, record and edit attendance data for a single term. It
uses a format very similar to the format found in the score chart. Before attendance data can
be recorded, a class must have calendar and attendance options set in the Class Options
window. Refer to the sections Setting Attendance Category Options (page 5-5) and Setting

The Attendance Chart
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Calendar Options (page 5-6) for help. Use the following information to guide your use of
the attendance chart.

■

■
■

■

■

■
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Each column represents a single date in the calendar for the class. No-school days are
grayed and cannot be selected. When entering attendance data, Easy Grade Pro will
automatically scroll over all no-school days.
Note that each column number indicates the number of days into the term.
You can enter the one- and two-character attendance codes by typing, clicking on marks
on the tool bar, by filling down and across, or by using the Find tool.
To add a note to an attendance mark, first double-click on a cell to open the student note
view of the Summaries window. Tools in this window allow you to quickly add dates.

Elementary teachers may choose to take attendance in a single class. The multi-class
progress report will find the class with the greatest number of attendance marks for a
student and use it when completing the attendance portion of the report.
To filter the dates displayed in the chart, use the menu to the left of the first column
number. You can choose between showing all days, the current day, current week,
current month or a selected range of dates. If the current day, week or month is
selected, the actual dates will automatically change at the right times.

■

■
■

To quickly hide all dates but one, click on the date you wish to view. When only one date
is visible, you may use the horizontal scroll bar to scroll through all dates while keeping
only a single date visible at a time. To return to the normal view, click on the date again.
You can use the Export Attendance tool to export one day’s attendance over a network.
The height of the rotated date titles can be customized. You can raise the titles so that
more student rows can be shown on your screen. To resize the title height, press and
drag the thick, horizontal line below the titles.

Press here and drag up or down

You can set up a seating chart to match your classroom, furniture included. Students can be
sorted into the seats randomly or in a variety of patterns. The arrangement of seats can be
copied to and from any class. In addition, attendance can be taken directly from the seats.
This section explains how to do all of this.

The Seating Chart

Setting up a seating chart
The first time the seating chart is entered, Easy Grade Pro automatically places the first 128
students into seats using a built-in arrangement. Most likely, this arrangement does not
match your situation. Use the guidelines below to create your own structure.
■

■
■

Use the Seat Format Options in the Class Options window to set the shape, size, name
format and attendance format of all seats in a class. See page 5-8 for help.
To move any seat, simply drag it to the desired location.
To swap two students, drag the first seat on top of the other. If you are swapping
students and one seat is rotated left or right and the other is not, be sure to drag the
upper-left corner of the first seat to the upper-left corner of the second. The names and
colors will be swapped; the orientation of the seats will not be swapped.
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■

■
■

■

Sort Tool
■

Add Furniture Tool

■
■

■
■

■
■

To move or swap a group of seats, first select the seats by clicking on each one while
holding down the shift key. Another way to select multiple seats is by dragging a
rectangle that encloses or touches all the seats. To move the group of seats, grab one
and drag. All the selected seats will move with it.
To deselect all selected seats, simply click on an empty place.
Use the items in the View menu to sort seats randomly or to sort using one of eight
patterns. The patterns use the order of the students in the Records window when
placing the students into seats.
To randomize your students, click the Sort tool or choose Randomly from the View
menu. This tool, when used only once, ensures that every student moves to a new seat.
To add furniture to a chart, choose Add Furniture from the Tool menu or click the Add
Furniture tool.
Furniture can be copied and pasted using the tools in the Edit menu.
To set the color, rotation or locked status of a seat, double-click on the seat or select the
seat and choose Seat Format from the Tool menu. The Seat Options window will open.

A seat that is locked cannot be moved or sorted.
To set the format or name of a piece of furniture, double-click on the item or select the
item and choose Seat Format from the Tool menu. The Furniture Options window will
open. To change the size, drag in the small rectangle in the lower corner of the item.
To delete a piece of furniture, select the item and click the Delete tool or press delete.
The structure of a seating chart and its furniture can be copied to and from classes within
a gradebook. Choose Copy from the Tool menu. When furniture is copied from one class
to another, it always replaces any furniture that the class might already have.

Taking attendance in a seating chart
Before a seating chart can be used for attendance, the class must have a calendar and
attendance categories, and the seat format must be set to allow attendance. These can only
be set in the calendar, attendance and seat views of the Class Options window. Choose
Class Options from the Edit menu to open this window. Once these have been set, it is easy
to take attendance from the seats. Use the guidelines that follow.
■

■

■
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The current date, if it is within the calendar for the class, will be displayed in the lowerleft corner of the window. Use the Set, + and - buttons to switch to other dates. If the
date is not the current date, it will be grayed. Attendance can be taken on any day.
One way to take attendance is to use the menu in the upper part of each seat. A second
way is to select seats and then click on an attendance code on the tool bar. No matter
how attendance is taken, the attendance code is displayed in the seat.
You can use the Export Attendance tool to export one day’s attendance over a network.

The student chart and the Records window (students view) have a lot in common. Both
display student names, ID numbers, gender, status, grade scale and twelve custom fields.
While the Records window displays one student at a time, the student chart can display all
students together. If you have a lot of student record data, the student chart is the better
place to work with the data. Many of the tools found in the other charts, such as fill, cut and
paste, find and filters are also available here.

The Student Chart

The student chart does display some data not found in the Records window. At the right end
of the chart, there are six columns with student comment numbers. Although it is easier to
enter student comments in the Summaries window, the student chart can be used to view
and edit groups of comments.
Use the following information to guide your use of this chart.
Data can be entered into any cell except the cells in the column of student names.
■
The gender, status, language, and scale fields actually are menus that appear and can be
used to select data.
■
The titles of the last twelve columns can be changed in the Records window. To open
this window, double-click in a cell below the title.
■
To change the order of the columns, press on a column’s title. The cursor will change to
a hand. Using the hand, drag the column left or right to the desired location.
■
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■

■

The Assignment Chart

To change the width of a column, move the cursor until it is over the vertical line to the
right of a column title. The cursor will change to a spreader bar. Press on the line and drag
the line to the desired location.
Like the score chart, you can move rows up and down by dragging on student names.
Students can be filtered in the normal way so that only the desired students are visible.
Text can be filled down, cut, copied and pasted from one column to another.

Just as the student chart is related to the student view of the Records window, the
assignment chart is related to the assignment view of the Records window. Both display
assignment names, maximum scores, points, dates, categories, special attributes, display
settings and notes. While the Records window displays one assignment at a time, the
assignment chart can display all assignments together.
When entering numerous assignments, it is easy to set the wrong category or enter the
wrong number of points. The assignment chart can be used to help ensure that your
assignment settings are correct, because it allows quick inspection of your assignments.
If you ever need to calculate student averages based on some but not all assignments, the
assignment chart can also be used to turn off assignments. First show only the assignments
to be turned off. You could select them and choose Show Selected from the View menu or
you could create a custom filter. Then change the status of the first assignment to Not for
Grade and fill it down to the remaining assignments. Choose Show All. The overall grades
for the students now reflect just the ones you want included.
The notes column can be helpful when creating custom filters. For example, you could enter
a code in the note field to show that the assignment is closed (all scored). A filter could be
set up to show only assignments that are still open.
Since the assignment chart is so similar to the student chart, refer to the prior section for
guidelines in using this chart.

9-6 THE OTHER CHARTS

Chapter 10

Security
Electronic data is susceptible to a variety of problems: unauthorized access, software
conflicts, hardware breakdowns, etc. This chapter explains how to prevent unauthorized
access to a gradebook, and it presents a plan to ensure that if a problem does occur, student
data will not be lost. This chapter also shows how to use the TA mode to protect a gradebook
and the privacy rights of students when others assist in the managing of student data.

A gradebook that is locked cannot be opened unless a password is typed into a special
window (shown below). Easy Grade Pro allows a gradebook to be locked automatically or
manually. If your gradebook is used primarily at school, you may want the gradebook to lock
automatically whenever it is closed. If your gradebook is only occasionally used at school, you
may want it to lock only when you manually select the Lock tool from the File menu or from
the tool bar. In either case, a password must be typed to regain access.

How to lock a
gradebook

Lock Tool

To set the teacher password and lock option, use the Security view of the Gradebook
Options window which is opened from the Edit menu. Refer to the section Setting Security
Options on pages 5-10 and 5-11 for help.
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Forgot the Password?
If you are unable to get back into your gradebook because you don’t remember the password, don't worry -- there is a way. First
double-check all of the passwords you’ve used in the last year. Try them in your current gradebook as well as in recent backups.
If you still can’t get in, contact ORBIS Software. See the appendix for the address, phone number and times in which technical
support is available. If you are a registered user, you will be given a one-day password that will allow you to open the gradebook
and set a new password.

How to secure your
student data

Because computers are prone to problems, it is imperative that you follow a plan to protect
your student data. For greatest security, it is best to maintain student data in different ways
and at different locations. Here is a simple 3-part plan that might work for you:
■

■

■

Save Copy Tool

Part 1: Daily Backups. Make a copy of your gradebook every day that you make
changes. Save your backup to the server, your computer’s hard drive or another
convenient volume. One day’s backup can replace a prior day’s backup copy. For greater
security, use the name of the day of the week for your backup (Monday, Tuesday, etc.)
and let one day’s backup replace the backup from the prior week.
Part 2: Printed Reports. Produce printed reports for each class on a weekly basis.
Part 3: Archived Backups. At least twice a month and at important times, make a
backup copy of your gradebook to a floppy disk or other removable media and store it
away from your site. Do not erase any copy until some time after a major term has ended.

To make a backup of your gradebook from within Easy Grade Pro, choose Save Copy from
the File menu or select the Save Copy tool.

What’s a Backup Copy for?
A backup copy of a gradebook is like an insurance policy -- it’s something that you hope you never have to use. The only time
you should have to use a backup copy is if your gradebook becomes damaged or inaccessible. Don’t get your gradebook and
its backup copies confused, and don’t work on a backup of your gradebook unless there is a good reason.

Using the TA mode

The TA or teacher assistant mode is designed to allow someone other than the teacher to
enter student data, while protecting the gradebook and the privacy rights of students. When
the TA mode is on, many student data fields are grayed and access to menus and tools is
limited.
It is suggested that, before turning on the TA mode, you use assignment and calendar filters
to hide all columns except for those to receive data from the TA.

TA Mode Tool
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To turn the TA mode on, choose TA Mode from the File menu or select the TA Mode tool.
The menu item becomes checked. If the teacher and TA passwords have not been set, a
prompt will appear directing you to open the Gradebook Options window where the
passwords and the TA access privileges can be entered. TA access options include entering
data into charts, switching charts, switching classes, adding assignments, copying data to
other classes and printing reports. Refer to the section Setting Security Options on pages 510 and 5-11 for help. To turn off the TA mode, choose TA Mode as before. The password
window will appear and the teacher password must be typed to regain full access.

Chapter 11

Summaries
Easy Grade Pro provides two powerful tools for analysis of student performance: the
Summaries window and the Mini-Summary window. Each can be a tremendous aid in
understanding the performance of students individually, on specific assignments, and as a
class. This chapter explains where to find and how to use these tools.

The Summaries window is one of the most important tools in Easy Grade Pro. It is capable of
displaying performance in eleven different ways. There are graphs, lists, calendars, notes and
comments. You can instantly jump to any view, class, student or assignment for thorough
analysis.
Use these tabs to switch
between the class, student
and assignment views.

To switch to
any class,
click here.

Using the Summaries
Window

Use these tabs to switch between the
graph, scores, attendance, notes and
comments views.

To switch to
any student,
assignment or
class, use
these.

There are several ways to open the Summaries window:
■
Select Summaries from the Chart menu.
■
Click the Summaries tool. If you first select a student, assignment or seat, the
Summaries window will display a summary of the selected item.

Summaries Tool
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■

Double-click a row number or column number in any chart (except for the seating chart)
to open the summary for that item.

To switch between the different views in the Summaries window, use the three tabs on the
left (Classes, Students, Assignments) along with the five tabs on the right (graph, scores,
attendance, notes, comments). The menus and buttons below the tabs allow you to quickly
switch to different classes, students and assignments.
Whenever you use the class menu to switch classes, Easy Grade Pro will attempt to find the
same displayed item in the new class. This allows you to quickly switch classes to see how a
student has done in other classes or to see how other classes have done on an activity.

Student Summaries

There are five student views in the Summaries window. Three of them provide information
about a student and two of them allow you to enter notes and comments about the student.
All of the information in these views can be included in progress reports. Generally, only a
single term is shown at a time but you can use the class menu to switch to any term.
Use the Student (Line) Graph to view changes in a student’s performance over the
course of a term. One line in the graph displays the overall grade; you can include up to three
additional lines to display performance in different categories. Select the Graph Options
button to set the categories and colors. The changes you make apply to the current class
only; when printing single-class progress reports, be sure to set the options for each class.
If you want to see a complete breakdown of a student’s overall grade, use the Student
Grades view. You’ll find the overall, term, completed work, category and assignment
grades. The assignments are sorted by category. Not only are scores, percents and grades
displayed, but also points. If you ever need to confirm or verify the calculations for a
student, the Student Grades view can make the task easy.
The Student Attendance view displays calendars with all attendance data for a student
for a term. Attendance totals for the current term as well as prior terms are found in a list. It
is easy to discover attendance trends and correlate attendance with class performance.
The Student Notes view (shown below) allows you to enter notes up to several pages in
length. Notes can be used to document events, record attendance notes and anything else
about a student. Notes can be for your eyes only or can be included in reports.
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The small Clipboard tool in the upper-right corner of the Summaries window can be used to
store reusable text, to paste stored text and to open the Clipboard window where you can
design text with variables. These variables are filled in with current student data at the time
the text is pasted into the summary window. Refer to the sections Setting Clipboard Text
Options and Using the Spell Check Window on pages 5-11 and 5-12 for help.
If you need to apply comments to students for progress reports or grade export files, use
the Student Comments view (shown below). There are two lists: the upper list displays
the comments that have been applied and the lower list displays the available comments.
■
■

■
■

■

■

To apply a comment, click the item in the lower list. Up to six comments can be applied.
You may find it helpful to switch to the other student views using the tabs at the topright before applying a comment.
To remove a comment, click the comment’s number in the upper list.
To change the order of comments in the lower list, press on a comment number and
drag up or down.
Use the small menu above the lower list to sort or edit the comments. If you wish to
have the student’s first name inserted in a comment, use the ^ symbol (shift-6).
Use the small menu above the upper list to erase comments, copy comments from the
prior term or copy comments to all students in the class.

There are four class views. Three of them provide information to you and one allows you to
enter notes. All of the information in these views can be included in different reports.

Class Summaries

The Class Graph view includes a bar graph showing the number of students who have
received each grade in the class. Grade and cutoff percents are shown below the bars. To
see the students that a bar represents, press on the bar; a list will appear (as shown on page
12-1). To print one or more class graphs, use the Class Graphs report.
The Class Ranked List view shows a list of students with overall points, percents and
grade names for the class. The list is ranked from highest to lowest average and provides
some statistical information at the bottom. To print this, use the Class Summary report.
If you need to view attendance totals by category and student, use the Class Attendance
view. Use the menu to choose the category to display. To print attendance totals for a class,
use the Attendance Summary report.
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The Class Notes view, like the Student Notes view, allows you to enter notes that can be
several pages in length. These notes are for your eyes only. The small Clipboard menu in the
upper-left corner can be used to store and reuse text. Refer to page 5-11 for an explanation
of how to use this menu. To print this view, use the Class Notes report.

Assignment
Summaries

There are two assignment views. All of the information in these views can be included in
different reports.
The Assignment Graph view includes a bar graph showing the number of students who
have received each grade on an assignment. Grade names and cutoff scores are shown
below the graph. You can choose any grade scale available to the class. To see the students
that a bar represents, press on the bar; a list will appear. To print one or more assignment
graphs, use the Assignment Graphs report.
The Assignment Ranked List view shows a list of students with scores, percents and
grade names on a particular assignment. The list is ranked from highest to lowest score and
provides some statistical information at the bottom. To print this, use the Assignment
Summary report.

Using the Minisummary
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The Mini-Summary floating window can display graphs and lists while you are working in
any of the five charts. It can also be used to attach footnotes to scores and show score
notes in the score chart. To make the summary window visible, choose Show MiniSummary from the Edit menu. Select the item again to hide it. Two items in the Gradebook
Options window can be set to automatically show, hide or move this window based on the
chart. The small menu in the upper-left corner of the window can be used to switch
between the seven views. These include Class Graph, Assignment Graph, Student Graph,
Student Grades, Student Attendance, Score Footnotes and Score Notes.

Chapter 12

Reports
Easy Grade Pro offers nineteen comprehensive reports. Regardless of which report you want
to print, you’ll follow the same steps: select the report, set options, preview one or more
reports and then print the reports to paper or disk. This chapter begins by explaining this
process in general. It then describes each of the reports.

1 To print any report, open the Print Reports window.
Open this window by clicking the Print tool or by selecting Print from the File menu.
Notice (below) that this window lists reports using tabs. The first tab lists all reports
meant for students. The second tab shows reports that correspond to the five screen
charts. All other reports are found under the last tab.

How to print reports

Print Tool

2 View/Edit the School (single-user version) or Teacher (site version) name.
This name will appear in the heading of each report.
3 (Optional) Click the Labels button to edit the labels for student reports.
See The Student Reports (page 12-3) and Setting Label Options (page 5-12) for help.
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4 Select a report and click Next.
After clicking, the Report Options window will open (shown below) where options for
the report can be set. Every report has its own Report Options window. To get a
description of an option, click on the help tool.
Select one of these to set the range of reports. If you select the third
option, be sure to select one or more items from the list.

Report-specific options are found here.

Click to set the
orientation,
enlargement, and
other printer
options.

Click to
preview the
report based
on the current
settings.

Click to save
the reports as
disk files.

Click to set the
number of pages,
the number of
reports per page
and to print.

5 Select the range of reports.
Use the three top buttons to select the students, assignments or classes for which
reports are to be printed. If you select the last one, be sure to select at least one list item.
6 Select the report options.
The boxes found in the lower half of the window have options for the report. Two
options found in all reports are font and font size. These are unique to each report.
7 Select Page/Print Setup and set printer options.
The Page/Print Setup window allows you to set the orientation, scale, and other printer
options.
8 Select Preview to view the reports.
Previewing a report before printing is a good way to learn how certain options affect a
report. You can use Print Preview to ensure that a progress report fits on one page, or
that you are maximizing the data that will fit. Previewing can save time and paper.
There are two views in the preview window: fit-in-screen (shown on the next page)
and full-size. The fit-in-screen view shows the entire page. Depending on the size of
your monitor, the details on the page may be unreadable. In this view, the cursor is a
magnifying glass. By clicking once on any part of the page, the view automatically
switches to the full-size view. The full-size view shows the page at its actual size. In this
view, the cursor becomes a hand. By pressing the mouse button, the page can be
grabbed and dragged about. Windows: Right-click on the image to display a contextual
menu with multiple zoom levels.
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9 Select ePrint or Print.
■
ePrint. Use this option if you want to attach a report to e-mail or to post a report on a
web page. Each report page will be saved as a separate file in PICT format (Macintosh) or
BMP (bitmap) format (Windows). Be sure to create a new folder (in the window that
appears) to hold all the files. The files will be automatically named using the student,
class or assignment names and page numbers unless you change the file name in the
next window. It is recommended that you do not change the name.
The PICT format is a standard graphics format on Macintosh computers and the BMP
format is standard on Windows computers. You may need to use conversion software to
convert the graphic to a less platform-specific format such as GIF or JPEG before
attaching the report to e-mail. Most programs used to create web pages can open and
convert PICT and BMP files to the formats used in web pages.
■

Print. Use this option to print paper reports. The standard Print window for your type of
printer will open where you can set some final print options and begin printing.

Printing Multiple Reports Per Page
Did you know that many printers today allow you to choose the number of pages to be printed on each sheet of paper? It does
this by shrinking each page the correct amount and placing the pages at different locations on the paper. These options are
known as layout options and can be found in the print window that appears after you click the Print button window.

Easy Grade Pro provides three comprehensive reports for communicating information about
individual students. This section describes the purpose and features of each report. The best
way to learn about each report is to explore the options and features in the Report Options,
Page/Print Setup and Preview windows.

The Student Reports

A feature common to all student reports is the ability to change report titles and labels. You
can customize the labels using options in the Gradebook Options window. Refer to the
section Setting Report Label Options on page 5-12 for help.
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The Progress Reports
Easy Grade Pro offers two progress reports. The multi-class progress report is designed
for teachers who have the same students in two or more classes. Each report can include a
great variety of information about a student’s performance in up to eighteen classes. The
single-class progress report is designed to report information about performance in a
single class only.

Single-class Progress Report

The features of the two reports are essentially identical. You can display student grades as
percents, grades or both. Introductory and postscript text can be included and Easy Grade
Pro can complete text variables with student data at the time of printing. A summary chart
with overall, term, category and other data for each class can be included as well as a chart of
some, just missing or all assignments. The line graph, note and comments found in the
Summaries window can all be included. Attendance data can be displayed using a chart,
calendars and list of dates. Blank comment lines can be added for handwritten comments by
teacher or parents.
There are some differences. In the multi-class report, if the report is customized to include
an overall grade, Easy Grade Pro will combine all the subject grades using the class weights
found in the Records window for each class. In the single-class progress report, you can filter
the students based on overall percent so you get just the reports you want.
The Missing Work Report
The missing work report can be used to inform students and parents about missing work. A
student’s missing work from more than one class can be included in the same report. (The
scores that count as missing are set in the Options window for each class. If you would like
blank scores to be included in this report, use the Change Scores tool to change blank
scores to scores that count as missing.) Introductory and postscript text can be included. You
can filter the missing work to include only missing assignments prior to a certain date.

Missing Work Report

The Chart Reports

The five screen charts (score, attendance, seating, student and assignment) can be printed
using the reports in the chart category. They can be printed to look exactly as they appear on
screen or can be customized in a variety of ways. This section describes the purpose and
features of each report, but you are encouraged to explore the options and features of each
report in the Report Options, Page/Print Setup and Preview windows.
You may find that the chart reports print better if you use the Page/Print Setup window to
set the orientation to landscape view (sideways printing) and the scale to between 60% and
80% if your printer allows this. This will maximize the number of columns per page.

Score Chart Report

The Score Chart Report
The score chart report mirrors the onscreen score chart. You can exclude the assignments
and include blank rows and columns so that it can be used like a paper gradebook. This
report works well as a poster because students can be sorted in a variety of ways and can be
displayed by name or ID. You can choose to include a footnote key on the last page.

Attendance Chart Report
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The Attendance Chart Report
The attendance chart mirrors the onscreen attendance chart. Like the score chart report,

you can include blank rows and then use it like a paper gradebook. A key to all of your
attendance codes can be included on the last page of the report.
The Seating Chart Report
Use this report to print your seating charts as they appear on screen. You can choose to
include a frame around the chart, to include furniture and to print in color. Use font size and
the options in the Page/Print Setup window to get the chart to fill a single sheet of paper.
The Student and Assignment Chart Reports
The student and assignment chart reports can be set to mirror the onscreen charts or they
can be highly customized to include the data and order of data that you desire. You can print
book number reports, parent name and phone number reports, etc. You can change the
report title so that it matches the data in the report.
There are eleven other reports that can be used to print graphs, rosters, charts, missing
work, labels and notes. Several of the reports include data found in the different views of the
Summaries window. This section describes the purpose and features of each report, but as
always, you are encouraged to explore the options and features of each report in the Report
Options, Page/Print Setup and Preview windows.
The Assignment and Class Graphs Reports
The assignment and class graphs reports allow you to print one or more bar graphs found in
the Summaries window. The options for these reports allow you to choose the scale, include
the class name, class average, standard deviation, cutoff scores, cutoff percents, and cutoff
grades. The graphs can be printed in color using the colors set in the Class Options window
for each class. It is suggested to use the Page/Print Setup window to set the orientation to
landscape view (sideways printing), and the scale to between 75% (six graphs per page) and
150% (one graph per page) if your printer allows this.

Seating Chart Report

The Other Reports

Class Graphs Report

The Assignment Summary Report
The assignment summary report includes ranked student lists on one or more assignments.
This report works well as a poster because students can be sorted in a variety of ways and
can be displayed by ID number. Options allow you to include the class name, date, average
and standard deviation. You can also display the students with scores, percents and grades.
The Attendance Summary Report
The attendance summary report includes a chart of students and attendance totals. You can
control the students who appear in the report and the number, content and order of the
attendance columns. You can include a key with attendance codes. It is suggested that you
use the Page/Print Setup window to set the orientation to landscape view (sideways
printing), and the scale to between 60% and 80% if your printer allows this.
The Class Summary Report
The class summary report is a concise compilation of overall points, percents and grades
broken down by term and category. This report works well as a poster because students can
be sorted and displayed by ID number. You can set the order and content of the columns. If
you include many columns, it is suggested that you use Page/Print Setup to set the
orientation to landscape view (sideways printing), and the scale to between 60% and 80%.

Assignment Summary Report

Class Summary Report
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The Class Missing Work Report
The class missing work report includes all missing work from selected classes in a single
report. Although this report is meant to be used by the teacher, it can be cut up and given
to students. You can choose to have the missing work sorted by student or by assignment. If
sorted by student, the report will list each student with all missing assignments. If sorted by
assignment, it will list each assignment with the students who have missing scores on it.
The Class Notes and Student Notes Reports
The class notes and student notes reports print the information in the two notes views in
the Summaries window. The student notes report can also include the notes found in the
Score Notes window.
Student Notes Report

Class Roster Report

The Class Roster Report
Class rosters are very similar to score chart reports except that the data cells are always left
blank. They can be used in a variety of ways, including being used to record grades. You can
set the width of the columns to normal or narrow. You can include room for hand-written
titles and even have Easy Grade Pro print your own custom column titles.
The Labels Report
Labels for envelopes, folders, lockers, etc. can be printed to all popular Avery™ labels for
laser printers and ink-jet printers. You can set the content of up to three lines on a label and
have the text justified to the left or centered. Since you can use cutoff percents for selecting
students, it is easy to print both progress reports and mailing labels for students who are
failing or at certain grade levels.
The Multi-class Gradesheet Report
The multi-class gradesheet report produces a chart with students and their overall or term
grades from multiple classes. Elementary teachers can use this report to list all subject
grades for each student. Secondary teachers can use this report to produce a single list of all
students and their grades. Since students can be displayed by ID and can be sorted in a
variety of ways, this report can be used as a poster.

Labels Report

You can choose to have the report display individual term grades or overall grades. A term
grade is the grade for a single term. If term options have not been set in the Class Options
window, then the overall grade and the term are the same.
The Show Combined Class Average option can be used to combine all displayed grades for a
student using the class weights found in the Records window. You can sort by the combined
class grade to produce a ranked list of students across multiple subjects or classes.

Multi-class Gradesheet Report
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Chapter 13

Porting
Porting refers to the transfer of data to and from your gradebook. To import means to copy
data from another file to your gradebook. To export means to create a new file that holds
data from your gradebook. This chapter explains the many ways you can port data.

Typically, importing is used to bring student names and other student record information
into a gradebook, but it can also be used to import options, scores and more. You can import
from two types of files: Easy Grade Pro gradebooks and text files. Text is a standard file
format that many programs use for transferring data to other programs and platforms.

How to import data

1 Select Import from the File menu to open the Import window.
The Import window (shown below) has two tabs. Under the first tab, you’ll find the
built-in import formats. Under the second tab you’ll find user-defined and other editable
formats. A format is used to specify the fields and structure of the data to be imported.

2 (Optional) Select the New Format button.
If the format that you need is not present, you can create one using the New Format
button. For help in creating a format, refer to the section How to create a porting
format on page 13-4.
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3 Select a format and click Next.
A window will appear allowing you to open the file from which to import. What happens
next really depends on the selected format. This is explained below.
■

Import Gradebook Window
■

“Easy Import” of Students
■

“Easy Import” of Scores

■

■

Import from an EGP Gradebook. Use this format to copy students, options,
assignments, a whole class, etc. from another Easy Grade Pro gradebook. The Import
Gradebook window will appear where you can select the items to be imported.
“Easy Import” of Students. Use this format to import students from most tabseparated or comma separated text files. Many database and school management
programs use this format when creating text files. The Easy Import window will open
where you can identify the fields in a record from the file. You must identify the first
and last names but all other fields are optional. You must also name the format so
that it can be added to the Import window where it can be reused directly.
“Easy Import” of Scores. Use this format to import scores from most tabseparated or comma separated text files. The records may be in any order as long as
each contains a score and an ID number (or student name) to be used for matching.
The Easy Import window will open where you must identify the score and the ID
number (or student name) fields. A menu at the top of this window allows you to
select the assignment to receive the scores.
Import Summary Comments. Use this format to import a list of summary
comments from a text file. This will replace the list in the Summaries window.
Other Formats. The formats that appear under the Other Formats tab can only be
used to import students and student record data from text files.

4 Select the records to import in the Import Preview window. Then click
the Import Selected Records button.
For most formats, the Import Preview window will appear so that you can select the
records (students) to be imported. Be sure to check that the data in the columns
properly match the column titles. If they don’t match, click the Cancel button.

How to export data
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Exporting is typically used to transfer student grade data to a program used to print report
cards but it can also be used to transfer all kinds of student information to word processor,
spreadsheet or database software to take advantage of the unique tools that these programs
offer. When exporting, you can create two types of files: Easy Grade Pro gradebooks and
text files. Text is a standard file format that many programs use for transferring data to other
programs, computers and platforms. Follow these steps:

1 Select Export from the File menu to open the Export window.
The Export window (shown below) has two tabs. Under the first tab, you’ll find export
formats that are built-in. Under the second tab you’ll find user-defined and other editable
formats. A format is used to specify the fields and structure of the data to be exported.

2 (Optional) Select the New button.
If the format that you need is not present, you can create one using the New button. For
help, refer to the section How to create a porting format on page 13-4.
3 Select the classes and students to be exported.
Select the classes from the list. Select the students using the menu near the bottom.
4 Select a format and click Next.
What happens after clicking depends on the selected format. The formats include:
■

■

■

■

■

■

Export One Class. Use this format to create a new gradebook with a single class.
This can be used to create a file with data to be imported into another gradebook.
Export Gradebook Template. Use this format to create a new gradebook with
gradebook and class options (from the selected class) only. Macintosh: The new
file can be used as a stationery template for creating new gradebooks. When you
open this template, a copy of the gradebook is created for you to work on, leaving
the original unchanged.
Export Attendance. This format is usually not selected directly because it is
automatically used whenever the Export Attendance tool is selected from the tool
bar. For help, refer to the section How to export attendance on page 13-5.
Export Report Card Data. This format can be used to export student grade data
to database software that prints custom report cards. This is explained in detail in the
section Using the Report Card Data format on page 13-7.
Export Summary Comments. Use this format to create a text file of the list of
comments found in the Summaries window.
Other Formats. The formats that appear under the Other Formats tab can only be
used to export student data to text files.

5 In the Export Preview window, click the Export button.
For most formats, the Export Preview window will appear so that you can verify the data
being exported.
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How to create a
porting format

This section explains how to create custom import and export formats. In many cases,
creating formats in easy. In some situations, creating the right format may require extensive
knowledge of file formatting and ASCII codes which is beyond the scope of this manual.
1 From the Import or Export window, click the New (Format) button.
The New Format window will open (shown below).

2 To add a field to your format, click on it and click the Copy button.
When the Copy button is clicked, the field is copied to the list on the right. If a field is in
the wrong position in the format list, press on it and drag it to the new location.
3 (Optional) Select the Quotes button.
Set this item if the data has (if importing) or should have (if exporting) quotation marks
around each field. Under most circumstances, Easy Grade Pro will remove quotation

marks automatically during importing.
4 (Optional) To customize a field, select it and click the Options button.
Easy Grade Pro automatically uses a tab-separated, text format. You may change the type
of field, the fill character, justification and delimiter. If you set the Field Data Required
item in an export format, Easy Grade Pro will block exporting until all required data are
complete. Any field that has been customized will have an asterisk appended to its name.

Need a CR/LF Record Delimiter?
If your format requires a carriage return/line feed combination at the end of a record, follow these steps: 1) change the delimiter
of the last field to CR (ASCII 13), 2) add a blank field to the format, and 3) change the delimiter of this field to LF (ASCII 10).

5 Name the format in the text field and click Done.
The name will appear under the Other Formats tab in the Import or Export window.
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Easy Grade Pro makes it easy to export attendance over a network. After entering
attendance data in the attendance or seating chart, the teacher can export the data in just a
few steps.

How to export
attendance

Macintosh: Although not required, the EGP Attendance Compiler software (a
companion product from Orbis Software) can be used by the attendance secretary to
compile all the individual teacher files for a day so that the data can be saved, printed,
recorded or placed into school management software. Contact Orbis Software for
information on this product.
For the exporting of attendance to be successful, careful preparations are required. These
are outlined next.
■
Attendance Folder. A folder must be set up on a shared volume to hold the daily
attendance export files. The pathname (name of folder, enclosing folders and volume)
must not change once exporting has begun. The volume should be automatically
mounted on each teacher’s computer.
■
Attendance Categories. Each teacher’s gradebook must have the school’s attendance
categories and codes. Although these can be set by each teacher using the Class Options
window, it is suggested that a gradebook template be used instead. Creating a
gradebook template is explained below.
■
Export Attendance Format. Easy Grade Pro has a built-in export format for
attendance. This format has the name Export Attendance and can be found under the
Built-in Formats tab of the Export window. It has the following fields:
Field 1
Field 2
Field 3
Field 4

■

■

Selected Date
ID
Last Name, First
Selected Day’s Attendance

If desired, you can create your own custom format but it should not have more than four
fields. See the section How to create a porting format on page 13-4 for help. In order
for Easy Grade Pro to automatically use your format, it must be named Export
Attendance. Every gradebook must have the custom format. Although it can be
imported into a gradebook, it is best to include the format in a gradebook template.
Calendar Settings. Attendance data cannot be recorded until calendar options have
been set in the Class Options window. The calendar settings for one term can be
included in a gradebook template.
Export Attendance Tool. The Export Attendance tool is used to start the export
process. It must be placed on either the tool bar or tool palette. To add the tool, press
and hold on any occupied or unoccupied tool location. Select the Export Attendance tool
from the menu that appears. It is best to include this setting in the gradebook template.

Export Attendance Tool

A gradebook template can be used to ensure that all teachers’ gradebooks have the same
settings. It also minimizes the work that teachers must do. First create a gradebook with the
right settings. Then create a template of the gradebook using the Export window. Refer to
the section How to export starting on page 13-2 for help. Teachers should create their
gradebooks directly from the template.
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Export Attendance Tool

Before you can export attendance, your gradebook must have the correct attendance
categories and export format. The Export Attendance Tool must be on the tool bar or tool
palette and the volume to receive your attendance data must be mounted on your
computer. You must know the name to use for your export file and the location in which it is
to be saved. Be sure to enter your attendance data in the attendance chart or seating chart
first. Then follow these steps:
1 Click the Export Attendance tool.
A small calendar will appear (shown below). This calendar will automatically display the
current date but you may change this by clicking on the calendar.

2 Click OK in the Calendar window.
After clicking, Easy Grade Pro will gather the attendance data for the selected date and
present it in the Export Preview window (shown below). This window is used to verify
the attendance data. Note that only students with attendance marks appear.

3 Click Export Records in the Export Preview window.
Even if you do not have any students with attendance data for the selected date, it is
important to export so that a file is created indicating that attendance has been sent.
If this is the first time that you are exporting attendance from the gradebook, the standard
Save dialog window will open allowing you to name and save the export file. Use the unique
name given to you. The location to save the file should be the attendance folder set up on a
shared volume. Easy Grade Pro will remember the name and location and use them
automatically in the future. If you saved the file using the wrong name or location, you must
reset Easy Grade Pro. To do this, click the Export Records button (shown above) while
holding down the option (Macintosh) or control (Windows) key. You will be able to reset
the name and location.
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This section explains the Report Card Data export format found in the Export window of
Easy Grade Pro. This format can be used to export student data to database software
designed to print your school’s report cards.

Using the Report Card
Data format

One of the more popular and affordable database programs available is FileMaker® Pro from
FileMaker Inc. (a subsidiary of Apple Computer, Inc.). It can be used to print your school’s
report cards using data from Easy Grade Pro. If the database is well-designed, the whole
process can be fairly easy. But to create a well-designed database requires skill and time.
Many resources are available to make the task easier. (Check out www.filemaker.com).
The Report Card Data format consists of 157 fields (listed below). Virtually every piece of
data about a student is included (other than individual attendance marks and assignment
scores). Even the text found in the Summaries window is included. This format results in a
tab-separated text file. The field information below is needed for creating a report card
database.
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32

Last Name, First
Last Name
First Name
ID
Gender
Status
Grade Scale
Language
Student Custom 1
Student Custom 2
Student Custom 3
Student Custom 4
Student Custom 5
Student Custom 6
Student Custom 7
Student Custom 8
Student Custom 9
Student Custom 10
Student Custom 11
Student Custom 12
Class Name
Class Weight
Class Custom 1
Class Custom 2
Class Custom 3
Class Custom 4
Class Custom 5
Class Custom 6
Class Custom 7
Class Custom 8
Overall Points
Overall %

33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64

Overall Grade
Class Rank
Class Average %
Class Average Grade
Current Term Points
Current Term %
Current Term Grade
Category 1 Points
Category 1 %
Category 1 Grade
Category 2 Points
Category 2 %
Category 2 Grade
Category 3 Points
Category 3 %
Category 3 Grade
Category 4 Points
Category 4 %
Category 4 Grade
Category 5 Points
Category 5 %
Category 5 Grade
Category 6 Points
Category 6 %
Category 6 Grade
Category 7 Points
Category 7 %
Category 7 Grade
Category 8 Points
Category 8 %
Category 8 Grade
Category 9 Points
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65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95
96
97
98
99
100
101
102
103
104
105
106
107
108
109
110
111
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Category 9 %
Category 9 Grade
Category 10 Points
Category 10 %
Category 10 Grade
Category 11 Points
Category 11 %
Category 11 Grade
Category 12 Points
Category 12 %
Category 12 Grade
Category 13 Points
Category 13 %
Category 13 Grade
Category 14 Points
Category 14 %
Category 14 Grade
Category 15 Points
Category 15 %
Category 15 Grade
#Missing Assignments
Completed Work Points
Completed Work %
Completed Work Grade
Term 1 Points
Term 1 %
Term 1 Grade
Term 2 Points
Term 2 %
Term 2 Grade
Term 3 Points
Term 3 %
Term 3 Grade
Term 4 Points
Term 4 %
Term 4 Grade
Term 5 Points
Term 5 %
Term 5 Grade
Term 6 Points
Term 6 %
Term 6 Grade
Term 7 Points
Term 7 %
Term 7 Grade
Term 8 Points
Term 8 %

112
113
114
115
116
117
118
119
120
121
122
123
124
125
126
127
128
129
130
131
132
133
134
135
136
137
138
139
140
141
142
143
144
145
146
147
148
149
150
151
152
153
154
155
156
157

Term 8 Grade
Term 9 Points
Term 9 %
Term 9 Grade
Term 10 Points
Term 10 %
Term 10 Grade
Master Attendance 1
Master Attendance 2
Master Attendance 3
Master Attendance 4
Master Attendance 5
Master Attendance 6
Master Attendance 7
Master Attendance 8
Master Attendance 9
Master Attendance 10
Attendance 1
Attendance 2
Attendance 3
Attendance 4
Attendance 5
Attendance 6
Attendance 7
Attendance 8
Attendance 9
Attendance 10
Attendance 11
Attendance 12
Attendance 13
Attendance 14
Attendance 15
Today's Date (short)
Comment 1 (number)
Comment 2 (number)
Comment 3 (number)
Comment 4 (number)
Comment 5 (number)
Comment 6 (number)
Comment 1 (text)
Comment 2 (text)
Comment 3 (text)
Comment 4 (text)
Comment 5 (text)
Comment 6 (text)
Student Summary Note
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Working Cross Platform
This chapter explains the information you’ll need to use an Easy Grade Pro gradebook on
both Macintosh and Windows 95/98/NT platforms.

Easy Grade Pro 3.5 for Macintosh and for Windows can share gradebooks easily and
seamlessly. Since both platform versions of Easy Grade Pro use identical gradebook formats,
you don’t have to convert them, save them in a special format or go through any importing
process. Just copy the gradebook from one platform to the other using a network or disk
and use the Open command in the File menu to open it.

The basics

It is important that you are running the same version of Easy Grade Pro on both platforms. If
you are using Easy Grade Pro 3.5.5 for Macintosh, then you should be using Easy Grade Pro
3.5.5 for Windows. Choose About Easy Grade Pro from the Apple menu (Macintosh) or
Help menu (Windows) to find version information. Versions of Easy Grade Pro earlier than
3.5.5 cannot be used for cross platform work. To obtain software and licensing to work on
both platforms, contact Orbis Software.
If both machines are connected via a network, transferring a gradebook is as simple as
copying the gradebook to the server and then from the server to the other machine. If they
are not networked, then you can use a floppy disk in PC format. Most Macintosh computers
include software (such as the PC Exchange Control Panel) that allows the computer to read
from and write to a PC floppy disk. Windows computers rely on a filename extension to
identify a document's type. When transferring a Macintosh gradebook to Windows, add.EGP
to the filename. For example, if your gradebook’s name is My Gradebook 1999, change it to
My Gradebook 1999.egp. You can open the gradebook on your Windows machine by
double-clicking using the left mouse button or by choosing Open from the File menu from
within Easy Grade Pro.

Transferring a
gradebook to Windows

IMPORTANT NOTE: Because floppy disks are unreliable, it is best to copy a gradebook
on a floppy disk to the computer’s hard disk before working with it.
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Transferring a
gradebook to
Macintosh

Differences between
the platforms

You can use a network or a PC floppy disk to transfer a gradebook to a Macintosh computer
(see the prior section). Be sure that the gradebook’s name has the extension .egp. You can
open a gradebook on the Macintosh by choosing Open from the File menu. However, since
Macintosh computers rely on a hidden code to identify a document's type and Window’s
documents don’t have these codes, you cannot open a gradebook by double-clicking on it
unless you have PC Exchange, Macintosh Easy Open, File Exchange or some other utility
program that maps PC extensions to Macintosh applications. The PC Exchange Control Panel
is shown below with the proper mapping set. It only needs to be set once.

Easy Grade Pro for Windows is virtually identical to Easy Grade Pro for Macintosh. If you
already know Easy Grade Pro 3.5 for Macintosh, you will find Easy Grade Pro for Windows to
be completely familiar. There are some differences as follows:
• Menu item terminology, keyboard keys, keyboard equivalents (accelerators) for menu
items and highlight colors have some platform-specific differences.
• Different characters are found in fonts (typefaces). Some characters on the Mac (such as
the check mark) are not available in Windows and vice versa. Easy Grade Pro will convert
some of these to alternatives when transferring between the two platforms.
• Easy Grade Pro for Macintosh saves all Page Setup (orientation, paper type, scaling, etc.)
options. Easy Grade Pro for Windows does not; you will need to reset any non-default
page setup options each time you print.
• Macintosh printers typically allow scaling (enlargement/reduction). Since fewer Windows
printers offer this, Easy Grade Pro for Windows allows smaller typefaces in reports and
allows right-clicking in the print preview window to select from multiple zoom levels.
• When ePrinting, Easy Grade Pro for Macintosh creates files in PICT format. Easy Grade
Pro for Windows creates files in BMP (bitmap) format. These formats are the most
common formats on their respective platforms.
• Easy Grade Pro for Windows offers status bar help, right mouse clicking to open
contextual menus and automatic reopening of the last gradebook. Easy Grade Pro for
Macintosh offers balloon help and allows quick-searching by pressing the option key with
the first letter of the item’s name.
• When exporting a text file on either platform, Easy Grade Pro automatically puts a CR at
the end of each record. In the Windows world, many programs expect to find a CR/LF
combination. See page 13-4 for an explanation of how to add a LF to the end of a record.
• Easy Grade Pro for Windows requires a color monitor displaying at least 256 colors. Easy
Grade Pro for Macintosh does not require a color monitor.
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Appendix
This appendix includes sections on FAQs, contacting ORBIS Software and an index.

When a student’s overall percent was manually calculated using a progress
report, it was different from Easy Grade Pro’s value. How come?
Unless a progress report displays the points earned on each assignment and the category
weights (if used), it is usually not possible to verify an overall percent using a student report.
For explanations of how Easy Grade Pro calculates grades, refer to the sections How to add
assignments on page 7-1 and How is a student’s overall percent calculated? on page 7-6.
Use the Student Grades view of the Summary window to view a breakdown of grades.

FAQs (Frequently
Asked Questions)

How do I set up my 5-point scoring system?
Method 1: Using Regular Numbers. You can simply type numbers into score cells. However,
since 1 out of 5 is a 20%, 2 out of 5 is a 40%, etc., a traditional grade scale will be too high.
You can create a grade scale in the Class Options window that better matches the wide
range of percents. Since students may be troubled by the lower percents in student reports,
you may want to set the display of grades to GRADES ONLY in the Report Options window.
Method 2: Using Special Scores. You can create special scores to be used instead of regular
numbers. Your special scores could be +5 (100%), +4 (90%), +3 (80%), +2 (70%) and
+1 (60%). The plus symbol is used to minimize confusion with true numeric scores. Create
Special Scores in the Scores view of the Class Options window. You can choose to enter
special scores by direct typing or by using shortcuts but not both. Open the Gradebook
Options window to the General view to set your preference. Refer to the sections Setting
Special Score Options on page 5-4 and Setting General Options on page 5-10 for help.
How do I drop multiple scores for a student?
Easy Grade Pro drops scores in real time, changing the dropped scores as new scores are
added. It performs extensive calculations to ensure that the process always results in the
greatest possible improvement. Because of this, only one score can be automatically
dropped per student. However, there is an easy way to manually drop multiple scores using
APPENDIX A-1

the Change Scores tool. Refer to the section How to drop scores on page 8-9 for help.
Why are my calendars set to the wrong date?
This indicates that the computer’s clock is not set properly or the clock’s battery is dead.
How do I start a new term? How do I combine grades across terms?
Choose Start New Term from the Tool menu. If you wish to combine term grades and
attendance data, refer to the section Setting Combine Term Options on page 5-6 for help. If
you wish to display prior-term data in the score or attendance charts of your new term, refer
to section How to add special data columns on page 8-10.
How do I handle a weighted final exam?
The prior term grades are wrong in my current class. What’s going on?
Refer to the section Setting Combine Term Options on page 5-6.
Why am I getting disk error messages when saving to floppy disks?
Floppy disks are prone to a variety of problems, especially when used with two or more
computers. See Floppy Disk Alert! on page 4-2.
How do I get my gradebook to fit on a floppy disk?
Choose Compress from the File menu. You can set compression to occur automatically as
you work. Refer to the section Setting General Options on page 5-10 for help.
Can Easy Grade Pro be networked?
A gradebook can be placed on a network allowing access from any computer. A gradebook
cannot be opened by multiple users simultaneously. Macintosh: The Easy Grade Pro
application (site version) can be placed on a server allowing multiple users to work from a
single installation. Windows: The application must be installed on each computer.
How do I get the overall grade to reflect a subset of the assignments?
Change the status of the assignments to be excluded to Not for Grade in the assignment
chart. Refer to the section The Assignment Chart on page 9-6 for help.
Lines or margins don’t appear properly in printed reports. (Windows)
Make sure that you are using the correct printer driver. Windows: From the Start menu,
choose Settings:Printers. Macintosh: From the Apple menu, select the Chooser. The
printer driver should have the name or model of your printer as part of its name. If necessary,
install the driver software using the installation disk that came with the printer. Be sure you
have selected the proper paper type and other settings in the Page/Print Setup window.

Contacting ORBIS Software for Technical Support
ORBIS Software provides free technical support to registered users. Send e-mail to orbissoft@aol.com, fax to 253-848-6505 or call
during the hours of 4:00-6:00 P.M. Pacific Time, Monday - Friday to (253) 848-6899. Before you contact us, please be sure that you
have read the FAQs above and you have searched this manual and your computer manual and could not find a solution. Be
sure to have the following information: your registration (serial) number, the version number of Easy Grade Pro (e.g. version
3.5.5), and a clear description of the problem. You are strongly encouraged to be at your computer when calling.
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A

Add Assignment 3-3, 7-1, 8-2, 8-8, A-1
Add Class 4-3
Add Furniture 9-4
Add Student 6-1
Allow typing of Grades and Special Scores 5-3, 55, 5-10, 8-1
Allow typing of Special Score Shortcuts 5-5, 510, 8-1
Assignment Chart 7-1 to 7-6, 8-9, 9-1, 9-6, 12-5,
A-1, A-2
Assignment Graph 11-4
Assignment Order 6-6, 7-4
Assignment Ranked List 11-4
Assignment Summary Report 11-4, 12-5
Attendance Categories 5-1, 5-5, 9-4, 13-5, 13-6
Attendance Chart 3-2, 3-7, 5-7, 5-10, 6-4, 6-6,
9-1, 9-2, 12-4, 13-6, A-2
Attendance Summary Report 11-3, 12-5
Automatic Drop 8-9

B

Backups 4-2, 10-2
Balloon Help 2-1
BMP (bitmap) format 12-3, 14-2
Blank Scores 8-2, 8-4, 12-4
Built-in Formats 13-5

C

Calendar Options 5-6, 9-2, 13-5
Can be dropped 7-2, 8-9
Categories 3-2, 3-6, 5-1, 5-3, 5-5, 5-6, 6-6, 7-2,
7-6, 8-11, 9-4, 9-6, 11-2, 13-5, 13-6
Category Weighting 5-4, 5-7, 6-6, 7-6
Change Scores 8-2, 8-4, 8-9, 12-4, A-1
Class Attendance 11-3
Class Graph 11-3, 11-4, 12-5
Class Missing Work Report 12-6
Class Name 4-4, 12-5
Class Notes 11-4, 12-6
Class Options 3-2, 3-6, 3-7, 4-1, 5-1 to 5-10, 8-2,
8-5, 9-1 to 9-4, 12-5, 12-6, 13-3, 13-5, A-1
Class Ranked List 11-3
Class Summary Report 11-3, 12-5
Class Weight 4-3, 12-4, 12-6
Clear 5-5, 6-5, 7-5, 8-12, 9-1, A-2
Clipboard Text 5-11, 6-2, 8-6, 11-3
Color Options 5-2
Combine Term 5-6 to 5-8, A-2
Comments 5-4, 9-5, 11-1 to 11-3, 12-4, 13-2,
13-3
Compress 4-2, 5-10, A-2
Continuous Search Mode 3-6, 8-3
Copy Class Data 3-5, 5-2, 5-8, 6-1, 6-3, 7-3
Cross platform, working 14-1
Curve 8-6, 8-7
Custom Data 4-3, 6-2
Custom Filters 6-2, 7-3, 8-11, 8-12, 9-1, 9-6
Custom Labels 4-3, 6-2

D

Delete 3-3, 5-2, 5-3, 5-11, 6-1, 6-5, 7-1, 7-5, 81, 8-5, 8-7, 8-8, 8-10, 8-11, 9-1, 9-4
Display Options 5-9
Display Scores 7-3
Dropping Scores 2-2, 8-9

E

“Easy Import” 13-2
Editing 5-3, 5-11, 6-3 to 6-5, 7-4, 7-5, 8-1, 8-4,
9-1
EGP Attendance Compiler 13-5
English 4-3, 5-12, 6-2
ePrint 12-3, 14-2
Export 9-3, 9-4, 11-3, 13-1 to 13-7, 14-2
Export Attendance 9-3, 9-4, 13-3, 13-5, 13-6
Export Gradebook Template 13-3
Export One Class 13-3
Export Report Card 13-3
Export Summary Comments 13-3
Extensions, filename 14-1
Extra Credit 7-2, 7-6, 8-8

F

Fill Across 8-2, 9-1
Fill Down 3-4, 8-2, 9-1
Filters 3-4, 3-7, 3-8, 5-3 to 5-5, 6-2, 7-3, 8-2, 84, 8-10 to 8-12, 9-1, 9-5, 9-6, 10-2
Final Exam 4-3, 5-8, A-2
Find Tool 3-5, 8-3, 8-11, 9-1, 9-2
Font 3-6, 5-9, 12-2
Footnotes 5-4, 5-12, 6-6, 8-5, 11-4
French 5-12, 6-2

G

Gender 6-2, 9-5
Grade Scale 3-2, 3-6, 5-2, 5-3, 5-6, 6-2, 8-2, 8-6
to 8-8, 9-5, 11-4
Gradebook Options 3-6, 4-1, 5-1, 5-3, 5-9 to 512, 6-2, 8-1, 8-6, 10-1, 10-2, 11-4, 12-3
Grading Style 7-2

H

Help Window 2-2, 2-2
Hide Selected 8-11
Highlight 3-4, 3-6, 5-9, 6-4, 7-4, 7-5

I

ID Numbers 5-7, 6-2, 9-5, 12-5, 13-2
Import 3-2, 3-4, 5-2, 5-3, 6-1, 7-1, 8-12, 10-2,
11-1, 13-1 to 13-6
Import from an EGP Gradebook 13-2
Import Summary Comments 13-2

L

Labels Report 12-6
Lock 3-9, 5-8, 5-10, 6-6, 7-2, 8-8, 9-4, 10-1, 126, 13-4, A-2
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M

Master Category 5-5
Maximum Score 6-6, 7-2, 7-6, 8-1, 8-6 to 8-8, 96
Mini-summary 5-4, 5-10, 5-12, 8-5, 11-1, 11-4
Missing work 5-4, 5-5, 5-9, 6-2, 8-11, 12-4 to 126
Multi-class Gradesheet Report 12-6
Multi-class Progress Report 5-5, 9-2, 12-4

N, O

Negative Points 7-3, 7-6
Networking A-2
New Gradebook 4-2, 13-3
Not for Grade 7-2, 8-2, 8-4, 9-6, A-2
Notes 5-4, 5-9, 5-11, 5-12, 6-6, 8-1, 8-5, 9-6, 111 to 11-4, 12-5, 12-6
Open Score Note 8-5
Orbis Software 10-2, 13-5, A-1, A-2
Other Formats 13-2, 13-3, 13-4

P

Page/Print Setup 3-9, 12-2 to 12-5
Palettes 5-10
Password 5-10, 5-11, 10-1, 10-2
Paste 5-11, 6-4, 6-6, 7-4, 7-5, 8-4 to 8-6, 9-1, 94 to 9-6, 11-3
PC Exchange 14-1, 14-2
PICT format 12-3, 14-2
Points 3-3, 3-4, 3-7, 5-4, 5-6, 5-7, 6-6, 7-2 to 76, 8-8, 8-10, 9-6, 11-2, 11-3, 12-5, A-1
Points Earned 6-6, 7-2, 7-6, 8-8, A-1
Points Possible 6-6, 7-2, 7-3, 7-6, 8-8
Print Preview 3-9, 3-10, 12-2
Print Reports 3-9, 4-4, 5-12, 12-1
Printing Multiple Reports per Page 12-3
Progress Report 3-2, 5-4, 5-5, 6-6, 7-2, 7-3, 7-6,
8-2, 8-5, 8-7, 9-2, 11-2, 11-3, 12-2, 12-4,
12-6, A-1

R

Recombine Terms 5-7
Records 3-3, 3-9, 4-1, 4-3, 4-4, 5-2, 5-6, 5-8, 512, 6-1, 6-3, 6-5, 7-1, 7-4 to 7-6, 9-4 to 96, 12-4, 12-6, 13-2, 13-6
Registration 1-2, A-2
Repeat a score 8-1
Report Label Options 5-12, 12-3
Report Options 3-9, 3-10, 7-3, 7-6, 12-2 to 12-5
Rotate 8-10, 9-3
Rounding 5-1, 5-3

S

Save Changes 4-4
Save Copy 4-4, 10-2
Score Categories 5-1, 5-3
Score Chart 3-2 to 3-9, 5-7, 5-9, 5-10, 6-3, 7-2,
7-3, 7-5, 8-1 to 8-12, 9-6, 11-4, 12-4, 12-6
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Score Chart Report 12-4, 12-6
Score Footnotes 5-4, 6-6, 8-5, 11-4
Score Notes 5-9, 5-11, 5-12, 6-6, 11-4, 12-6
Scroll to Left 5-10
Scroll to Top 5-10
Seat Format 3-2, 5-8, 9-3, 9-4
Seating Chart 3-8, 3-10, 5-8, 5-9, 6-3 to 6-5, 812, 9-1, 9-3, 9-4, 11-2, 12-5, 13-5, 13-6
Seating Chart Report 12-5
Security 5-10, 10-1, 10-2
Serial Number 1-2
Shortcuts 5-5, 5-10, 8-1, A-1
Show All 8-11, 9-6
Show Grades 5-9
Show Selected 8-11, 9-6
Single-class Progress Report 11-2, 12-4
Sort Assignments 7-4
Sort Classes 4-4
Sort Seats 9-4
Sort Students 6-3
Spanish 5-12, 6-2
Special Data Columns A-2
Special Scores 3-2 to 3-4, 5-1, 5-3 to 5-5, 5-10,
8-1, 8-2, A-1
Special Status 7-2, 8-2, 8-8, 8-9
Spell Check 5-11, 5-12, 8-6, 11-3
Structure of a Gradebook 4-1
Student Attendance 5-6, 11-2, 11-4
Student Chart 5-2, 5-12, 6-1, 6-6, 9-5, 9-6
Student Comments 9-5, 11-3
Student Grades 6-6, 8-8, 11-2, 11-4, 12-4
Student Graph 11-4
Student Notes 11-2, 11-4, 12-6
Student Notes Report 12-6
Student Order 6-3, 6-4
Student Reports 5-9, 5-11, 5-12, 12-1, 12-3
Summaries Window 3-9, 6-6, 9-2, 9-5, 11-1 to
11-4, 12-4 to 12-6, 13-2, 13-3, 13-7

T

TA Mode 5-11, 10-1, 10-2
TA Password 5-10, 10-2
Teacher Password 5-10, 5-11, 10-1, 10-2
Technical Support 10-2, A-2
Tool Bar 2-1, 3-2 to 3-6, 3-9, 4-4, 5-1 to 5-3, 55, 5-12, 6-1, 6-3, 7-1, 7-4, 8-1, 8-2, 9-2, 94, 10-1, 13-3, 13-5, 13-6
Tool Palette 3-2, 3-3, 4-4, 5-3, 5-10, 5-12, 8-2,
13-5, 13-6
Transferring a gradebook 14-1, 14-2
Transferring a Student 6-6

U, V, W

Un-combine Terms 5-7
Undo 3-4
Value% 5-4
Warnings 5-10, 8-1
WD 6-2, 6-4, 6-5, 8-11, 8-12
Weights 5-3, 5-4, 5-7, 5-8, 7-6, 12-4, 12-6, A-1
Withdraw 6-1, 6-2, 6-4

